Fast Track to Windows Vista

By Team Digit
Not Quite “Shorthorn”

We’ve been following its progress since the Longhorn-code-name days, and there were news reports that went about calling it “Shorthorn,” mostly because WinFS was dropped from what is now Vista. However, even without WinFS—and without some of the other trappings that Longhorn was supposed to ship with—you’ll find, when you use it, that Windows Vista is quite the wonderful new operating system it was supposed to be.

This book doesn’t assume, one way or the other, that you have Vista installed. If you do, this is a quick-start guide; if you don’t, this is a sneak-peek. Read it and decide whether it’s what you wanted it to be.

For those curious about how it all came to be, we have, in Chapter 2, how Vista evolved; for those just curious, we have Chapters 3 and 4, where we go into what’s new and what’s inside the new OS. Then on, we get to describing how things work in Vista, with, naturally, an emphasis on how the working departs from XP (which, we’re assuming, most of you are currently using).

Search—whether on the Internet or on our own systems—can only take on greater importance with time, and Vista has a radically new approach to Search, which is why we’ve devoted an entire chapter to it.

The security of Vista as an OS has been (as you’d expect it to be) much-discussed, and we discuss the final implementation of Vista’s security measures in Chapter 6.

DirectX 10 is here, and that’s what many of you are probably most excited about: we talk of Vista’s gaming possibilities in the last chapter, on Gaming. The other chapters are a walkthrough to most of the other functions in the new OS, but always with an emphasis on how things have evolved since XP.

It was hyped, then de-hyped, then hyped again—and now it’s here. Whether or not you’ll use it, read what follows to get a flavour for the best operating system from Microsoft ever—and we’re happy this Fast Track coincides with our Anniversary Issue!
## CONTENTS

### Chapter 1  A New Vista
1.1 The Different Versions 10
1.2 Upgrading To Vista 19
1.3 Hardware Requirements—Minimum And Optimal 20
1.4 Changes For Vista Deployment 21
1.5 Windows Vista x64 Support, Migration, And Deployment 27

### Chapter 2  Windows Vista: A Troubled Journey
2.1 Windows Vista: A Troubled Journey 29
2.2 Redoing The plumbing 31
2.3 Of DRM And Communication 39

### Chapter 3  Inside Vista
3.1 Thread Priority And Scheduling 43
3.2 Multimedia Class Scheduler Service 44
3.3 File-based Symbolic Links 45
3.4 Cancelling I/O Operations 46
3.5 I/O Priority 47
3.6 Memory Management 48
3.7 Advanced Features 49
3.8 Reliability, Security, And Power Management 51

### Chapter 4  What’s New In Vista
4.1 Authentic, Energetic, Reflective, and Open 59
4.2 The New Start Menu 60
4.3 Startup and Shutdown 62
4.4 Exploring Vista 64
4.5 Something Old, Something New 68
4.6 Speech Recognition 87
4.7 Tablet interface 91

### Chapter 5  Search
5.1 Starting With Search 94
5.2 Where Does It Come From? 98
5.3 Saved Searches 99
Before Vista, picking up an operating system was a simple enough task—give us the latest. It’s not so simple when it comes to Vista—you actually need to choose what’s right for you. Here, we walk you through the differences in the various versions, and also talk about installation.
1.1 The Different Versions

Microsoft released Windows XP in two different versions: Windows XP Home Edition and Windows XP Professional Edition. It was readily apparent that the Pro version was the more feature-packed, a point underlined by its higher cost. But soon enough, Microsoft added further versions to the XP stable—the many iterations of Windows XP Media Center Edition, Windows XP Tablet PC Edition, and Windows XP Professional x64 Edition; and then there were spin-offs such as XP Starter Edition and XP Embedded.

With Vista, things are much complex. The most confusing aspect with Windows Vista is deciding which version is right for your needs, and for your budget. It is not clear why Microsoft decided to break up Vista into multiple software units, but the decision has been made: Windows Vista comes in a variety of versions which offer different sets of features in accordance with the market they are targeted at.

Microsoft has created six Vista product editions—targeted at everyone from the entry-level to high-end, premium customers. Plus there are versions specific to national markets such as the N editions for the European Union (EU) and the K editions for South Korea. Add to this 32-bit and x64 variants, and the total tallies up to more than 15 different versions of Vista!

Our task is therefore to clearly list out the various features and quirks of each of these editions, with a view to better understanding just which Vista is the right one to go with.

At least one point becomes very clear—if you want the version that has it all, you need to pick up Windows Vista Ultimate. Vista Ultimate is also the only version that ships with both 32-bit and 64-bit versions inside the same package. For Home Basic, Home Premium and Business Editions, you need to order a 64-bit version separately (you only need to pay for the shipping and handling costs).
### Flavours

<table>
<thead>
<tr>
<th>Version</th>
<th>Comparable to</th>
<th>x64</th>
<th>Meant for</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Vista Starter</td>
<td>XP Starter Edition</td>
<td>✗</td>
<td>Select countries only, with new PC purchase</td>
</tr>
<tr>
<td>Windows Vista Home Basic</td>
<td>XP Home Edition</td>
<td>✓</td>
<td>Retail</td>
</tr>
<tr>
<td>Windows Vista Home Basic N</td>
<td>XP Home Edition</td>
<td>✓</td>
<td>Retail, European Union (EU) only</td>
</tr>
<tr>
<td>Windows Vista Home Premium</td>
<td>XP Media Center Edition</td>
<td>✓</td>
<td>Retail</td>
</tr>
<tr>
<td>Windows Vista Business</td>
<td>XP Professional Edition</td>
<td>✓</td>
<td>Retail</td>
</tr>
<tr>
<td>Windows Vista Business N</td>
<td>XP Professional Edition</td>
<td>✓</td>
<td>Retail, EU only</td>
</tr>
<tr>
<td>Windows Vista Enterprise</td>
<td>XP Professional Edition</td>
<td>✓</td>
<td>Volume-license only</td>
</tr>
<tr>
<td>Windows Vista Ultimate</td>
<td>NA (Not Applicable)</td>
<td>✓</td>
<td>Retail</td>
</tr>
</tbody>
</table>

### The User Interface

<table>
<thead>
<tr>
<th>Features</th>
<th>Home Basic</th>
<th>Home Premium</th>
<th>Business</th>
<th>Enterprise</th>
<th>Ultimate</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic UI</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Aero UI</td>
<td>✗</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Windows Flip 3D</td>
<td>✗</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Live Taskbar Thumbnails</td>
<td>✗</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Instant search</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Live content organization in Explorer</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>
### Mobility features

<table>
<thead>
<tr>
<th></th>
<th>Home Basic</th>
<th>Home Premium</th>
<th>Business</th>
<th>Enterprise</th>
<th>Ultimate</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Mobility Center</td>
<td>Partial</td>
<td>Partial</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Sync Center</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Tablet PC functionality</td>
<td>✗</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Touch screen support</td>
<td>✗</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Windows SideShow</td>
<td>✗</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

### Reliability Features

<table>
<thead>
<tr>
<th>Vista Features</th>
<th>Home Basic</th>
<th>Home Premium</th>
<th>Business</th>
<th>Enterprise</th>
<th>Ultimate</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backup and recovery—real time</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Scheduled backup</td>
<td>✗</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Windows ShadowCopy</td>
<td>✗</td>
<td>✗</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>System image backup and recovery</td>
<td>✗</td>
<td>✗</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Encrypting File System (EFS)</td>
<td>✗</td>
<td>✗</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Windows BitLocker Full Drive Encryption</td>
<td>✗</td>
<td>✗</td>
<td>✗</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Windows SuperFetch</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Automatic HDD defragmentation</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>
### Performance Features

<table>
<thead>
<tr>
<th>Vista Features</th>
<th>Home Basic</th>
<th>Home Premium</th>
<th>Business</th>
<th>Enterprise</th>
<th>Ultimate</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows ReadyDrive</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Windows ReadyBoost</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>64-bit processor support</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Maximum RAM (32-bit version)</td>
<td>4 GB</td>
<td>4 GB</td>
<td>4 GB</td>
<td>4 GB</td>
<td>4 GB</td>
</tr>
<tr>
<td>Maximum RAM (64-bit version)</td>
<td>8 GB</td>
<td>16 GB</td>
<td>128+ GB</td>
<td>128+ GB</td>
<td>128+ GB</td>
</tr>
<tr>
<td>Physical processor support</td>
<td>1</td>
<td>1</td>
<td>2</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>Processor core support</td>
<td>Unlimited</td>
<td>Unlimited</td>
<td>Unlimited</td>
<td>Unlimited</td>
<td>Unlimited</td>
</tr>
</tbody>
</table>

### Bundled applications

<table>
<thead>
<tr>
<th>Vista Features</th>
<th>Home Basic</th>
<th>Home Premium</th>
<th>Business</th>
<th>Enterprise</th>
<th>Ultimate</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Home</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Calendar Basic</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Windows</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Contacts</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Windows Sidebar</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Games Explorer</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Premium games</td>
<td>✗</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>
# Digital Media Features

<table>
<thead>
<tr>
<th>Vista Features</th>
<th>Home Basic</th>
<th>Home Premium</th>
<th>Business</th>
<th>Enterprise</th>
<th>Ultimate</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Photo Gallery</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Themed photo slide shows</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Windows Media Player 11</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Windows Media Center</td>
<td>×</td>
<td>✓</td>
<td>×</td>
<td>×</td>
<td>✓</td>
</tr>
<tr>
<td>Windows Media Center HDTV and CableCard support</td>
<td>×</td>
<td>✓</td>
<td>×</td>
<td>×</td>
<td>✓</td>
</tr>
<tr>
<td>Xbox 360 Media Center Extender compatibility</td>
<td>×</td>
<td>✓</td>
<td>×</td>
<td>×</td>
<td>✓</td>
</tr>
<tr>
<td>Windows Movie Maker</td>
<td>✓</td>
<td>✓</td>
<td>×</td>
<td>×</td>
<td>✓</td>
</tr>
<tr>
<td>Windows Movie Maker HD format support</td>
<td>×</td>
<td>✓</td>
<td>×</td>
<td>×</td>
<td>✓</td>
</tr>
<tr>
<td>Windows DVD Maker</td>
<td>×</td>
<td>✓</td>
<td>×</td>
<td>×</td>
<td>✓</td>
</tr>
</tbody>
</table>

Pretty flavours all in a row!
Now that we have a better matrix on what the versions of Vista are like, let’s take a closer look at the product matrix and see if we can whittle down the versions, filtering to the best option for you.

**Windows Vista Starter Edition**: This version is for a specific set of countries and regions—markets so price-sensitive that cutting costs calls for an extremely cut-down and basic variant of Windows Vista: the Starter Edition. Note that since this cannot be purchased at a retail store, so this is filtered out of the product matrix.

<table>
<thead>
<tr>
<th>Vista Features</th>
<th>Home Basic</th>
<th>Home Premium</th>
<th>Business</th>
<th>Enterprise</th>
<th>Ultimate</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Account Control (UAC) Windows Security Center</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Windows Defender</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Windows Firewall</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Internet Explorer 7 Protected Mode</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Phishing Filter (IE7 and Windows Mail)</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Windows Update (can access Microsoft Update)</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Parental Controls</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td>✓</td>
</tr>
</tbody>
</table>
## Networking features

<table>
<thead>
<tr>
<th>Feature</th>
<th>Home Basic</th>
<th>Home Premium</th>
<th>Business</th>
<th>Enterprise</th>
<th>Ultimate</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network and Sharing Center</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Improved wireless networking</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Improved power management</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Number of supported simultaneous peer network connections</td>
<td>5</td>
<td>10</td>
<td>10</td>
<td>10</td>
<td>10</td>
</tr>
<tr>
<td>Windows Meeting Space</td>
<td>View only</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Improved file and folder sharing</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Network Projector support</td>
<td>✗</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Presentation Settings</td>
<td>✗</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Remote Desktop</td>
<td>Client only</td>
<td>Client only</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Join domain (Windows Server/SBS)</td>
<td>✗</td>
<td>✗</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Offline files and folder support</td>
<td>✗</td>
<td>✗</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>IIS Web Server</td>
<td>✗</td>
<td>✗</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

**Windows Vista Home Basic N and Windows Vista Business N:** These versions were created at the behest of the European Union regulators, who felt it necessary to ask for feature removal from
Microsoft’s current and future operating systems, in lieu of alleged monopolistic practices. These “N” versions thus drop all media-related technologies such as Windows Media Player and Windows Movie Maker. Once again, these have little to do with India and therefore can be overlooked.

**Windows Vista Enterprise Edition**: Functionally similar to Windows Vista Business, this version is only available to Microsoft’s Software Assurance (SA) customers via volume licensing. This leaves the rest of us with four Vista editions to consider: Ultimate, Home Premium, Home Basic, and Business. To make our choice between these versions even more clear, let’s tabulate the features each version brings us or removes. We shall break down Vista into broad feature categories and then evaluate the different versions based on these feature sets.

### Other Windows Vista features

<table>
<thead>
<tr>
<th></th>
<th>Home Basic</th>
<th>Home Premium</th>
<th>Business</th>
<th>Enterprise</th>
<th>Ultimate</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Anytime Upgrade</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>×</td>
<td>×</td>
</tr>
<tr>
<td>Windows Ultimate Extras</td>
<td>×</td>
<td>✔</td>
<td>×</td>
<td>×</td>
<td>✔</td>
</tr>
<tr>
<td>Speech recognition support</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Accessibility Settings and Ease of Access Center</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Windows Welcome Center</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>XPS document support</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Windows Fax and Scan</td>
<td>×</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
</tbody>
</table>

Microsoft’s current and future operating systems, in lieu of alleged monopolistic practices. These “N” versions thus drop all media-related technologies such as Windows Media Player and Windows Movie Maker. Once again, these have little to do with India and therefore can be overlooked.

**Windows Vista Enterprise Edition**: Functionally similar to Windows Vista Business, this version is only available to Microsoft’s Software Assurance (SA) customers via volume licensing. This leaves the rest of us with four Vista editions to consider: Ultimate, Home Premium, Home Basic, and Business. To make our choice between these versions even more clear, let’s tabulate the features each version brings us or removes. We shall break down Vista into broad feature categories and then evaluate the different versions based on these feature sets.
As seen in the table on the previous page, the Basic Edition lives up to the name: it’s indeed quite basic. This point is made clearer as we take a look at the other features that define the Vista experience. Security is the cornerstone for Vista, unsurprisingly so; even the Basic variant retains the major security features. Only parental features are dropped in the business variants.

For the most part, the choice boils down to Vista Home Premium, Business, or Ultimate. Home Premium corresponds to where the Windows XP Media Center Edition is today, and offers some home theatre features in addition to the general feature set. Vista Business is similar to where Windows XP Professional is today (note that XP Pro does not offer high-end media solutions either). Windows Vista Ultimate is, of course, the version that has everything, and is a superset of the rest. Those who don’t mind paying should definitely check out Vista Ultimate.

### Upgrading

<table>
<thead>
<tr>
<th>Previous OS</th>
<th>Home Basic</th>
<th>Home Premium</th>
<th>Business</th>
<th>Ultimate</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows XP Professional</td>
<td>Clean install</td>
<td>Clean install</td>
<td>In-place option available</td>
<td>In-place option available</td>
</tr>
<tr>
<td>Windows XP Home</td>
<td>In-place option available</td>
<td>In-place option available</td>
<td>In-place option available</td>
<td>In-place option available</td>
</tr>
<tr>
<td>Windows XP Media Center</td>
<td>Clean install</td>
<td>In-place option available</td>
<td>Clean install</td>
<td>In-place option available</td>
</tr>
<tr>
<td>Windows XP Tablet PC</td>
<td>Clean install</td>
<td>Clean install</td>
<td>In-place option available</td>
<td>In-place option available</td>
</tr>
<tr>
<td>Windows XP Professional X64</td>
<td>Clean install</td>
<td>Clean install</td>
<td>Clean install</td>
<td>Clean install</td>
</tr>
<tr>
<td>Windows 2000</td>
<td>Clean install</td>
<td>Clean install</td>
<td>Clean install</td>
<td>Clean install</td>
</tr>
</tbody>
</table>
1.2 Upgrading To Vista

While purchasing a standalone unit is an option, you might also consider upgrading to a version of Vista from your current Windows OS (most likely XP). Your choices depend on the version of Windows currently running on your PC and the type of computer hardware you have to run certain features. Here’s how you can start planning for an upgrade to Windows Vista.

1.2.1 The options

You can upgrade from your current edition of Windows XP or Windows 2000 to a corresponding or better edition of Windows Vista by purchasing and installing an upgrade copy of Vista. If you’re upgrading multiple PCs in a household, you can look at the Windows Vista Family Discount. Depending upon the version of Windows you’re upgrading from, Vista will either force a clean install or will allow you to install over the older OS (In-place option).

<table>
<thead>
<tr>
<th>Previous OS</th>
<th>Home Basic</th>
<th>Home Premium</th>
<th>Business</th>
<th>Ultimate</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows XP Professional</td>
<td>Clean install</td>
<td>Clean install</td>
<td>In-place option available</td>
<td>In-place option available</td>
</tr>
<tr>
<td>Windows XP Home</td>
<td>In-place option available</td>
<td>In-place option available</td>
<td>In-place option available</td>
<td>In-place option available</td>
</tr>
<tr>
<td>Windows XP Media Center</td>
<td>Clean install</td>
<td>In-place option available</td>
<td>Clean install</td>
<td>In-place option available</td>
</tr>
<tr>
<td>Windows XP Tablet PC</td>
<td>Clean install</td>
<td>Clean install</td>
<td>In-place option available</td>
<td>In-place option available</td>
</tr>
<tr>
<td>Windows XP Professional X64</td>
<td>Clean install</td>
<td>Clean install</td>
<td>Clean install</td>
<td>Clean install</td>
</tr>
<tr>
<td>Windows 2000</td>
<td>Clean install</td>
<td>Clean install</td>
<td>Clean install</td>
<td>Clean install</td>
</tr>
</tbody>
</table>
Note from the above table that upgrade options are not available for versions of Windows earlier than Windows 2000. These versions require you to install a full copy of Windows Vista. Also, for those of you currently using Windows 2000 Professional or Windows XP Professional x64, you are eligible for an upgrade copy to a corresponding or better edition of Windows Vista, but a clean install is required.

1.3 Hardware Requirements — Minimum And Optimal

Microsoft classifies computers capable of running Vista into two categories—you have the Vista Capable computer, which can run the OS but not with all the visual features, and then you have the Vista Premium Ready computer, which will be capable of running Vista in all its glory. A Vista Capable computer needs to have a processor running at least 800 MHz, 512 MB of RAM, and a DirectX 9 class graphics card. A Vista

<table>
<thead>
<tr>
<th>Windows Vista System Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Hardware</strong></td>
</tr>
<tr>
<td><strong>Processor</strong></td>
</tr>
<tr>
<td><strong>Memory</strong></td>
</tr>
<tr>
<td><strong>Graphics card</strong></td>
</tr>
<tr>
<td><strong>Graphics card’s memory</strong></td>
</tr>
<tr>
<td><strong>Hard drive capacity</strong></td>
</tr>
<tr>
<td><strong>Hard drive free space</strong></td>
</tr>
<tr>
<td><strong>Optical drive</strong></td>
</tr>
</tbody>
</table>
Premium Ready computer requires a 1 GHz processor, 1 GB of RAM, and a graphics card with at least 128 MB of memory (DX9-compatible too, as well as one with the correct WDDM drivers). Such a Premium Ready PC will take advantage of Vista’s high-end features.

Essentially, Windows Vista’s Basic interface will work with virtually any graphics hardware that supports Windows XP or 2000. Also offered is the Windows Vista Classic look, which essentially offers the same UI as Windows 2000 does. While a PCI-Express video card is not a requirement for Windows Aero, Microsoft recommends one over an AGP device due to the greater bandwidth of the interface.

1.4 Changes For Vista Deployment

Quite a few changes have been made to the manner in which you can deploy a Vista image. These changes are made throughout the deployment system—from the nature of the image file used to the tools support this new format. Let’s take a look at the broad changes that have been made to make deployment and component change easier:

1.4.1. Windows Vista And Images

While deploying a version of Vista for your business, one of the most important points to keep in mind is that the nature of the install has changed in several ways: Vista essentially installs off an image file, which is compressed on the DVD media it ships with. Installation thus is a two-step process of first copying this image file to disc and then decompressing it and installing the drivers etc. This also means that the size of the image for Vista deployment has gone through the roof: while you could deploy an XP install on a single CD, the basic image size of Vista itself is close to 2 GB, compressed at that. The uncompressed version of the same can easily span more than 5 GB. Add to this additional programs
that your business would require in a typical Vista deployment, and that one-CD requirement can easily become a DVD worth of data, if not more.

The good news is that like the previous iteration, Vista supports deployment from various resources, be they local such as an optical disc, or networked. You could also deploy Vista on a USB memory stick, if you have one large enough (and if your BIOS supports USB booting). Finally, the I386 directory no longer exists. Instead, all components, whether installed or not, reside in the Windows directory.

1.4.2. Implications of enhanced security
The new security features under Vista will also change the deployment environment a bit. Under Vista, even an administrator account does not have all the rights needed to make system-level changes. These rights are throttled to a higher-level, as and when needed, by Vista’s User Access Control (UAC) system. Interestingly though, non-admin accounts can install drivers under Vista, which should reduce support calls from employees installing their own hardware on their PC. A possible support headache to keep in mind while deploying is that Vista no longer grants full rights to all programs—thus, programs which assumed access to drives and registry under Windows XP will be redirected automatically by Windows Vista to other directories under the user’s profile.

Vista’s firewall is now two-way, instead of just inbound like it was under XP. This new firewall is fully configurable via Group Policy.

Windows Vista Ultimate and Enterprise versions ship with BitLocker, which allows entire drivers to be encrypted (the OS volume). The encrypted volume can be read using the right keys and only from Vista. BitLocker requires that your motherboard support the Trusted Platform Module (TPM) 1.2. The unlock key can be stored externally on a USB drive.
1.4.3. Vista is more modular
Vista is a completely modular operating system: security updates, language packs, and service packs are simply components which can be added on to the basic Vista image. For deployment of these components over your enterprise, tools such as the Package Manager can be used. Before you deploy Vista, you need to configure which of the components to install; this is done by enabling the components as required, using a tool such as the Windows System Image Manager.

Vista can be patched before it is deployed on to your network. This is another benefit of having a componentised image—you can apply changes and service the image file both online and even offline when Vista is not running.

Since drivers are also treated as components under Vista; they too can be added and removed easily. This means that driver updates or new drivers can be pushed just-in-time into the OS image, when the machine boots for the first time.

1.4.4. Text-Mode installation is gone
With the introduction of an image file for Vista, the text-based pre-installation routine of previous versions is now gone. Instead, Vista first copies the entire image to the storage device, and the image is then decompressed and installed. Once this image is installed, the OS does the necessary customisation tweaks needed for the computer—this is done in accordance with the components selected before deployment (refer point above).

1.4.5. Boot.ini is gone
Under Windows XP, the Boot.ini file is used to pass OS and drive information to the boot loader and prepare the disk for booting. This file is no longer used under Vista. Instead, a new boot loader called “bootmgr” reads boot configuration data from a special file named BCD. To maintain an edit the content of this BCD file, a new tool called bcdedit.exe is used.
1.4.6. Settings are XML-controlled
Configuration information that was earlier stored in various text files find a new home under Vista: Unattend.txt, sysprep.inf, cmdlines.txt, and winbom.ini are now all replaced by a single XML file called unattend.xml.

You can still edit the file in question using a text editor of your choice, the Windows System Image Manager tool mentioned above can be used to inspect the Vista image to determine which settings are available for deployment, allowing you to configure each one.
1.4.7. No more HAL complications
Under Windows XP, different hardware abstraction layers called for multiple images to configure and deploy. You might have thus needed two or more images for a single platform; each additional image bringing added costs and complexity.

Windows Vista can now detect which HAL is required and can automatically install it—you are no longer forced to create iterations for different HALs.

1.4.8. Windows PE to rule them all
For a while now, Windows PE (Pre-installation Environment) has been the deployment tool of choice for various organisations. However, you need to be a Software Assurance partner with Microsoft in order to get access to this tool. This is no longer the case under Vista: you can now download Windows PE 2.0 from Microsoft’s Web site and use it freely to deploy licensed copies of Vista. Windows PE 2.0 offers better performance from 32-bit and 64-bit networking stacks and tools. It also supports tools such as Windows Scripting Host and VBScript.

Much like Vista, Windows PE 2.0 comes as an image that is componentised, and can be serviced both online and offline. While it offers some new components such as language packs, font packs, Windows Recovery Environment, and MSXML 3.0, other components can be easily added using available tools peimg.exe—including mass storage devices, which no longer require any special handling.

1.4.9 The WIM format
The image format used under Vista is file-based, and is called the Windows Imaging (WIM) format. Being file-based, the images can be applied to a partition non-destructively. Thus during deployment, the user state can be saved locally instead of on a network server—which will reduce network traffic while deploying the OS. During deployment you may create an image file that contains the contents of either a single disk volume or a partition. Thus to capture a sys-
tem with multiple partitions, you would need to create multiple images. However, all these images can be stored as a single WIM file, since the WIM file format supports multiple images per file. The WIM file format also supports single-instance storage, so duplicate files (even from different images) are automatically removed. Thanks to this and compression, WIM images are smaller than images created by other tools. But the compression and other processing takes some CPU time while creating the images. The trade-off is thus of smaller size and thus less bandwidth consumption over a network versus worth the extra CPU cycles spent on creation.

Finally, you can also mount a WIM file as a file system, which can be then read and modified as it works like a normal removable drive.

1.4.10. Vista Is Language-neutral
Many companies are required to support more than one language for their OS deployment. This was quite the chore under Windows XP, where multiple language support requires addition of an English Multilanguage User Interface with the required language packs. Windows Vista, though, is language-neutral. Language packs act as components to the base image and can be added and removed in accordance with an organisation’s requirements. The servicing of the Vista core is also language-agnostic, and only security updates would generally be required to serve Vista installs of different languages. Configuration of the deployment is also language-neutral and one unattend.xml can be used for all languages that the organisation finds necessary to support.

Windows XP supports different languages in two ways. You can either deploy localised versions of Windows XP, requiring a different image for each language, or you can deploy an English Multilanguage User Interface (MUI) version with added language packs.
1.5 Windows Vista x64 Support, Migration, And Deployment

If your organisation is considering migrating to the x64 side of the server and processor pool, then these few pointers might be of use. Microsoft provides a version of the Windows Pre-installation Environment (Windows PE) specifically for the x64 architecture. However, since x86 and x64 systems have hardware parity, you could also use the 32-bit version of the PE to deploy a 64-bit system. While using unattend.xml, though, Windows PE needs to be architecture-specific: as winnt32.exe must run under the same architecture it is deploying. Since Windows PE does not have a 32-bit compatibility layer, and winnt32.exe under x64 is a 64-bit application, 32-bit Windows requires 32-bit Windows PE. The same applies for 64-bit versions of Windows, which require 64-bit Windows PE.

If you are thinking of upgrading your OS from a 32-bit path to 64-bit, things get a bit difficult. You cannot upgrade from any version of Windows XP (x86 or x64) to Windows Vista x64. Windows Vista on x64 systems is a clean-installation-only product. You might thus consider a migration to 64 only under a fresh hardware upgrade.
It’s finally here—following its predecessor by more than five years—the longest time span between two releases of a Microsoft Windows product. Windows Vista is here. Along the way, Vista has been mocked as a wannabe to OS X, even a has-been when compared to various distros of Linux. After such a troubled journey, does Vista offer anything new, or is it just old wine in a new bottle? Let’s find out in the chapters that follow.
2.1 Windows Vista: A Troubled Journey

Windows Vista has been Microsoft’s most disparaged project yet. The freshly-squeezed OS has been labelled many things: from nothing more than a pretty skin on Windows XP to a complete disaster in terms of consumer traction and appeal. The truth lies buried beneath the pile of rubble that has been bad press for Microsoft in general, and bitter aftertaste from the Microsoft antitrust legacy.

Vista started off as perhaps the most ambitious vision that the Redmond giant has dared to dream. With time, that vision had to take a back seat to reality and what has finally been released has disappointed many. Before we get into the innards of this new operating system, to understand exactly what has changed and what those changes entail, let’s take a quick look at how we came to Vista.

Flashback to 2001, when Windows XP was about to be released to the world. In typical Silicon Valley fashion, whispers of the next OS from Microsoft were already doing the Internet rounds. Back then, the codename for the OS was Longhorn, and Longhorn was slated as the interim release between Vista and the next major release of Windows termed Blackcomb. For the curious: these codenames are derived from geographical locations around British Columbia—Blackcomb was a ski resort, much like Whistler (the codename for Windows XP), while Longhorn was a strip of earth that you needed to traverse to get to Blackcomb from Whistler—the codenames were thus emblems of intent for the OS in question, and somewhat poetic.

Vista, or Longhorn back then, was a bit more ambitious than the product we now see on retail shelves. The idea was to create an operating system for the new age—one that would intelligently store your data, and route it transparently from locale to locale as you moved computers. It was meant to leverage several technologies including a SQL database for storing disparate content; a com-
prehensive search built upon that server; a peer-to-peer foundation for communication; managed code to offer better security and code hygiene; and a vector-based graphical engine to display the OS on to the monitor.

Longhorn was slated to ship in 2003; the delay to its actual date would be one of the reasons for the derision it faced. The delay in question was set rolling at the end of 2001: this was when Windows XP faced the major UPnP vulnerability (the vulnerability could allow anyone to take over a target computer), and the fallout from that security flaw forced Microsoft to re-evaluate the very nature of the organisation and reshuffle resources internally—it was now decided that XP needed better armour against attacks before resources could be allocated to any successor. Of course, there were several other factors—the entire project had to be rebooted at least once, and Microsoft itself saw a drastic change in its structure with Windows veteran and Microsoft group vice president Jim Allchin declaring that Vista would be his last project within the halls of Microsoft.

Between XP and Vista, the company was determined to improve the security of its Windows OS—a welcome proposition to what was plagued by worms, viruses, malware, and buffer overflows. During the transition from intent to betato the final build, many features were cut from Longhorn—the most infamous being the SQL-based file system called WinFS. Other major cuts included a new scripting shell codenamed Monad (now known as PowerShell), and a PC-to-PC synchronisation tool. Monad was removed for security reasons as it was deemed likely to open the consumer version of Vista to the same kind of hacks and exploits Microsoft was eager to leave behind. WinFS was removed just prior to the Longhorn reboot mentioned above—no solid reason was given for the feature-drop; many consider it to be a little too ambitious an undertaking. Features from WinFS were initially planned to make it to Vista post-release but even those plans were shelved. As things stand, components of WinFS are now slated to trickle into other MS products such as ADO.NET and Microsoft SQL Server. The syn-
chronisation tool was considered not ready for prime-time and might make it to our Desktops sometime in the near future.

Windows Vista underwent a thorough beta testing phase—it was tested and evaluated by the largest group of beta testers MS has ever shared their OS with till date. Come November 2006, the OS was considered ready for manufacturing. December 2006 saw the release of the business edition of Vista, while the consumer release took place on 30 January 2007.

Microsoft Vista is an operating system long overdue: not just from the perspective of the operating system’s own tumultuous release cycle, but from an industry point of view as well. Technology has marched to the steady, relentless beat of progress, while the Windows OS has been caught lingering in the past—dragged down by its own history and success. In many ways, Vista could not be a revolutionary OS thanks to the gargantuan install base it might potentially alienate (or worse, leave open to competition). So what we have here is a compromise—a system that cleans up all that it can, while still retaining the Windows DNA; and most importantly, an OS that lays down the foundation for future development in the Windows ecosystem.

In the chapters to come, we will explore these ramifications in some detail, starting with the aspect of Vista that most seem to be unable to look beyond—its visual interface.

2.2 Redoing The plumbing

Microsoft has been monopolising the operating system space for a good while now. With such domination comes historical baggage. It is very difficult to exhaustively change the innards of the operating system without forcing incompatibility on to the very same customers that curse your name at every Blue Screen of Death. Then there is the little detail of resting on your laurels...
The point here is that in such scenarios, technologies tend to stack over each other to form—not a delicious sandwich with everything in it—but a leaning tower of impending doom, a technological time bomb sitting on a fault line. Such has been the legacy of the Windows family of products: bandage old technologies with just enough new code to not break the old while clumsily introducing the new. Windows Vista aims to address this ill of Windows with swooping changes made to several internals of the OS, the least of which, gaining the most attention, is the User Interface (UI) itself. But before we do that, we need to take a quick look at the various changes that Vista has introduced at the backend of the operating system.

2.2.1 A View To The Future
Back in the olden days, people gasped in amazement over the marvel that was the VGA card: it brought colour and resolutions unheard of. Spreadsheets were suddenly more fun, and games, more real and dangerous. Before we get into further details, let’s quickly understand what most operating systems are build around: APIs, or Application Programming Interfaces, are a bunch of instructions that tell a program how to interact with another program. An operating system is generally a bunch of such interconnecting interfaces—each telling the other how to talk to files, or draw windows, or print your documents, and so on. One such API is used to draw everything that you see on screen in a Windows environment. Called the GDI (Graphics Device Interface), the API is a remnant from 1993—back from Windows NT 3.1. The API saw several layers added to it, which brought in more features and greater complexities to programmers.

2.2.2 The Limitations Of A Bitmap Interface
The GDI is a bitmap-based drawing tool for the operating system. When it draws elements on screen, it creates actual images much like one would in Paint or Photoshop. The problem with creating interface elements using pixels is that if those elements are required to say be resized or animated, the image loses its quality
and becomes “pixelated.” An interface built using such pixel-based elements, or bitmaps, is termed raster-based.

Being pixel-oriented, the GDI was also a bottleneck to readability as resolutions of monitors increased. A pixel-based system defines elements in absolute measures of pixels: you increase the resolution and the pixels get smaller, reducing the size of the element drawn as well. So while the GDI system suited the older display hardware well, as displays with higher pixel density became more common, you needed to squint at the screen to read anything. A raster API such as the GDI also had problems when it came to scaling and animating windows (transforms). Due to the rudimentary nature of earlier video cards, most of these transforms were performed by the CPU. Old video cards barely had enough memory to remember little more than the final screen that was to be rendered on your monitor. Moreover, they lacked the processing power to do any mathematical calculations on their own. Since GDI was programmed amidst this hardware status quo, the API lagged innovations in hardware.

The cards were then little more than a holding space for framebuffers (a framebuffer is memory that stores the video frame that needs to be displayed on screen). The cards would just be able to store that final image. It was the processor that needed to do the tasks of actually manipulating images to make them fit the myriad boxes, toolbars, menus, and so on. Being nothing more than a framebuffer also meant that the cards—and therefore the API—that leveraged the card did not keep historical track of various on screen elements. Say, for example, a desktop with two windows was rendered in this scenario: the window on top was an Explorer window browsing the C:, while just behind it was a Web browser window displaying a page.

Picture the Explorer window overlapping some area of the browser behind it. In this scenario, the API and the video card would just render the final scene of the two overlapping, without storing any information about the area of the browser window
that was overlapped by Explorer. If you were to move the Explorer window to show the entire browser, Windows would make an API call asking for the entire frame to be redrawn. This lack of information also made transparencies a difficult task to execute (there are workarounds to this, however).

Clearly, innovations were needed both on the hardware and the software level to better present interface information. These innovations first came about as Windows “accelerators.” These were hardware cards that would offload the most basic of rendering tasks from the CPU—tasks such as drawing lines and circles. These accelerators slowly gave way to graphic cards with more complex transformation and rendering strengths (NVIDIA’s GeForce series introduced such functionalities to consumer hardware). Today, a graphics card is powered by a processor powerful enough to handle complex mathematical calculations.

These cards also come with enough memory to dwarf hard drive capacities of old. Of course, the old technology of GDI and the GDI+ bandage that MS applied to the technology is woefully inadequate to leverage the graphical power at the operating system’s disposal. And this state persists with Windows XP: resolution-independent interfaces are out of the question, and applications have to run through multiple hoops and myriad “solutions” to offer visual effects such as window animations, transparencies, and window scaling.

2.2.3 Accelerating Windows
To address several of these shortcomings, Vista offers a completely new way to talk to the video hardware and draw onscreen elements. The biggest change is that it has done away with a raster-based (bit-mapped) API—Vista offers APIs which make use of vector-based drawings to draw elements of the window. A vector is essentially a mathematical formula used to define an object. So while a raster image of a 20-pixel-wide circle would comprise of a fixed number of pixels drawn on screen, a vector image of the same circle would just tell the computer to draw a circle with a diameter
Of Vista And DPI

With the advent of laptops, the screen resolution has gone up, and the screen sizes down. This has led to screens with a very high pixel density (DPI)—as much as 144 DPI as compared to the comfortable 96 DPI of a typical desktop computer. As DPI rises, the size of fonts decreases. Now Vista, ought to, in theory at least, be able to solve this problem through its use of vector graphics. Unfortunately, due to hardware limitations, the interface of Vista itself is not vectorised and thus not resolution-independent. Vista however, does offer a better DPI scaling solution than Windows XP; it even offers high-resolution icons to go along with high-DPI displays. As you can see in the images below, the DPI scaling is not perfect: everything is nice until the 144 DPI mark, after which the interface loses cohesion.

After the 144 DPI mark, power buttons in the Start menu get out of proportion, while the search icon in Windows Explorer gets out-of-place. The Sidebar gadgets do not scale at all.

To increase the DPI setting in Vista right-click on your desktop and click on Personalize. On the left-hand pane click on the “Adjust font size (DPI)” option.

Windows Vista

Inside Vista

Fast Track
of 20 mm, and fill it with the colour red. The important thing to note here is that vectors rely on real-world dimensions, while raster images are all pixel-based. Thus Windows XP would draw a line 50 pixels long, while Windows Vista would draw a line 5 cm long—the difference here is that when you increase the resolution of your monitor, the 50 pixels line would appear smaller because the pixels are now much closer to each other, but the 5 cm line would still be 5 cm long. Thus a vector-based interface can be resolution and pixel-density independent.

Secondly, Vista offers hardware-accelerated support for this API: through the 3D interfaces of DirectX 9 and 10, Vista can leverage modern video cards to simultaneously offer a visually rich and fast interface.

Along with the graphics API, Vista also throws out the old window manager and the windowing API. This total overhaul is termed the Windows Presentation Foundation.

As part of this package, Vista introduces a new window manager called the Desktop Window Manager (DWM). The DWM draws each window to its own buffer, thus tracking what each application is displaying at all times. These individual buffers can be filled, coloured, transformed, distorted, overlaid, and so on, to create all manner of effects.

Windows Presentation Foundation offer support to 2D and 3D shapes. It is also vector-based and hardware accelerated. WPF also removes absolute units for measuring onscreen elements: while Windows XP uses pixels to draw up screen elements, Vista goes for real-world units—thus, a button would be one-inch tall, or a line 4 cm long, or a font 8 points big, and so on. This ensures that the size of the on-screen element remains the same even if the pixel density of the screen increases or decreases.

One of the issues that programmers and designers of applications face today is that there is no clear way to separate the
underlying code of an application from the interface code itself. For example, while creating an accounting software, the programmers need to work closely with the interface designers to make sure that the buttons and scrollbars and so on, that the interface designers use to build the face of the program; are coded properly. Thus a programmer needs to work closely with artists and interface designers to ensure that parties involved are on the same page. This is an obvious bottleneck which is alleviated by Vista by offering different code paths for interface and backend. These paths are exposed via a markup language similar to HTML and leveraging XML technology—XAML (Extensible Application Markup Language) allows designers to create an application interface using XML over which the programmers can then either separately plug their code in, or embed the code into the XAML document itself.

2.2.4 All Those Left Behind

There are several implications going this route: on a software level, all future software will need to be .NET applications to take full advantage of Vista. This is since all APIs are written in .NET Framework 3.0; this is the first step to migrate the entire Windows ecosystem towards managed code. On a hardware level, this new design calls for an up-to-date video system for a PC. The video card, whether dedicated or onboard, would require at least 64 MB of RAM in order to serve the graphical whiz-bang Vista brings.

Apart from the memory requirement, the cards also need to support DirectX 9.0 and above—essentially, cards which lend pixel-shading support to Direct3D. A pixel shader is used to apply textures and special effects to a screen element; support for a pixel shader is needed in order to pull off effects such as transparency and shadow for a window. Apart from this direct hardware support, Vista also requires a new graphics driver in order to work as required. Under Vista a video card’s driver can be one of two models: the old XP-style driver, termed XPDM (XP Driver Model) and a driver model made especially for Windows Vista called WDDM (Windows Vista driver model). A video card offering a WDDM driv-
er for Vista will be best utilised, whereas a video card that supports D3D9 but does not come with a WDDM driver will run on old-school GDI and will not offer any Vista special effects.

It is interesting to note that while Vista bundles along DirectX10, the interface itself is built upon Direct3D 9 (a part of DirectX 9). This was done since the development of the new window interface and DX10 happened in parallel and the team in charge of Windows Presentation Foundation did not wish to delay their work or build such an integral part of Windows on potentially unproven technology. The D3D9 under Vista is however, not the same version found under Windows XP—some new extensions needed to be added to the API to facilitate multiple applications to use D3D. This extended version is called Direct3D 9Ex. This is largely why Vista calls for a special driver version in order to support Aero: the driver offers Direct3D 9Ex support.

For hardware and software that supports the new Presentation Foundation, Vista will run a version of its interface termed Aero. Aero offers some rudimentary display features that leverage the new technology, namely, transparency effects to individual windows; transition effects to maximising and minimising windows; live thumbnails on the taskbar which track and immediately display any changes made to each window (for example, a new chat message under MSN would immediately show up in the chat window’s thumbnail, even if the chat window is minimised). Aero also offers a new way to flip through open windows called Flip3D. If your video card is not DirectX 9.0 capable or if your card’s manufacturer is still without a WDDM capable, Windows will run Windows Vista Basic on your computer—without all the effects mentioned above. Practically speaking, if your system has seen a video card update in the past three years, it should be able to run Windows Vista as it was meant to be run. Laptop owners might face issues, however, if their onboard video chip does not offer DX9 support.
2.3 Of DRM And Communication

While graphics are grouped under the Windows Graphics Foundation, Vista also groups all communications services under a single banner called the Windows Communication Foundation (WCF). Communication here includes all application-to-application messaging such as asynchronous messaging between applications or distributed transactions and Web services. These features were present in previous versions, but Vista combines them under a single banner and makes working with them easier.

Microsoft has also exposed some workflow features under the heading of Windows Workflow Foundation (WF)—these are enterprise-class tasks. (A workflow is a task that requires decisions to be taken at various points and has a flow—say a branching task to process inventory.) WF not only exposes tools and APIs to easily set up such workflows, but also tracks and monitors the workflow and is involved in task scheduling. While the WGF is meant for Vista only, WCG and WF will be back ported to Windows XP to ease developers into this new mode of working with and creating applications. Finally, the trio of WGF, WCF and WF all combine under a single parent umbrella termed the WinFX, which is the brand name for the entire .NET framework. If you are a Windows developer, your future thus lies in learning and mastering .NET tools and getting familiar with the intricacies of managed code.

Vista also makes some low-level changes to the way multimedia is handled and presented by the operating system. The biggest change panders to the movie and the music industry by introducing elements for Digital Rights Management (DRM). Typically, these involve reducing the quality of a video or audio source if your hardware does not play nice with DRM requirements. These DRM restrictions are introduced and enforced by a media layer called the Media Foundation. In previous Windows versions, DirectShow was called for to support multimedia
requests such as video playback. Media Foundation is meant to replace DirectShow of old and handles all multimedia requests from applications such as audio and video editors, music and movie players, and so on. It essentially provides a protected path to media formats, so much so that a DRM-flagged content piece can potentially refuse to be scanned for a system threat (like a virus scan). Vista offers media to employ such protected paths which would only be accessible to plugins that have the proper authority to access the program.

Thus, a video player could potentially refuse to not only play a DRM protected file, but might also refuse to run a plugin, if it is not signed according to specification and requirement. This has been done to avoid hacks to HD content which might be either internal or via an outside attack through a third-party plugin. Apart from media protection, Media Foundation also introduces support for hardware acceleration of popular codecs. Windows XP provides such acceleration through the DirectX Video Acceleration for MPEG-2 content (generally used in DVDs). Media Foundation extends this codec support to the H.264 and VC-1 codecs. Videos encoded using these would thus play smoother, given the appropriate hardware support.

Windows Vista also refreshes the audio architecture as the Universal Audio Architecture. This new structure provides hi-fidelity support for professional creation of audio, apart from providing separate mixers to disparate audio streams from multiple software sources. Hi-fidelity sound also requires an architecture which offers the support needed in terms of greater bandwidth, such that latencies while working on the hi-fidelity sound streams are reduced. UAA does just that, especially at higher bitrates. It is also meant to allow simultaneously working with multiple sources of audio, be it playback or recording. Under UAA, all audio streams should now be high-definition playing at a frequency of at least 96 kHz at 24-bit; audio support should also extend to 5.1 channels wherever possible.
Vista can use the UAA to apply effects to audio streams. This could either be volume normalisation, speaker virtualisation (to simulate multiple sources via headphones), speaker positioning, or even environmental effects.

Now that we have better clarity on the improvements to the backend of Windows Vista, let’s take a look at some of the elements that are more visible than WinFX and its ilk—these would changes done to the user interface, additions of system-wide search, and numerous features such as ReadyBoost and the Sidebar.
Changes made to Windows Vista go deep—right up to the kernel level. In this chapter we will explore some of these changes made to ntoskrnl.exe, or the Vista kernel. The points will cover the new ways in which the kernel handles processes and prioritises threads, as also security, reliability, memory management, and more.
3.1 Thread Priority And Scheduling

An operating system has to juggle multiple processes, threads, and priorities. Essentially, all the programs running on your computer—be they operating system services or your favourite word processor—need to access a limited set of resources, the most limited and the most important of which is the computer’s process itself or the CPU—generally referred to as CPU cycles. These tasks of juggling are handled by the kernel of the OS, and this very act and manner of juggling has changed quite a bit under Vista.

Vista offers a new scheduler for multimedia tasks called the Multimedia Class Scheduler Service (MMCSS), which goes a long way in ensuring that multimedia applications are able to offer smooth and error-free playback to the end-user. Vista also ensures that tasks get their share of CPU cycles in a fair manner. This is especially necessary in this age of multi-core processors, and virtualisation at both the hardware and software levels.

In order to ensure that multiple threads get a go at a common CPU resource, a method of “interrupting” a process is employed at the kernel level. An “interrupt” essentially ensures that multiple processes get a shot at the CPU cycles. In many ways you can imagine the kernel as the personal secretary of the CPU who decides to allow one person to access the CPU every few milliseconds. Of course, things are not this simple. What the kernel does practically is that it “interrupts” whatever is happening every few seconds and then hands over the CPU to another task. This periodic interruption might be unfair to one or more processes: let’s continue with the personal secretary analogy. Say you have been given an appointment with the CPU at 10.00 AM, and you arrive there on the dot. Now the kernel might run its interrupt routine at exactly the same time that your meeting was supposed to take place (the kernel does this periodically, so there is no saying which process might get unlucky and when)—thus you can no longer meet with the CPU, since the kernel will count the time it has interrupted against your scheduled meeting; the kernel
would then push back your time with the CPU and hand over the next meeting slot to some other process. This is, of course, an unfair allocation of CPU cycles.

Now, each modern process has a cycle counter register (a small piece of silicon), which keeps track of what a thread is doing with CPU cycles. Vista makes use of this register to track precisely how many CPU cycles a thread executes. It also makes an estimate of how many cycles a CPU can execute in a clock interval, which helps the kernel to accurately ensure that each application is getting the turn it requires at the CPU. The unfair manner in which the kernel might push back a process’ scheduled go at the CPU is also alleviated: Vista does not count its own interrupt execution against a processes turn. This ensures that under Vista, a thread will always get a turn at the CPU.

### 3.2 Multimedia Class Scheduler Service

Vista also handles multimedia tasks in a neat manner. Today, there are many potentially CPU-intensive tasks always running in the background in an operating system. Threads from programs such as anti-virus scanners, e-mail clients, instant messengers, search services, content indexers and so on constantly vie for CPU cycles. So much so that you might experience audio skipping or video stuttering as these tasks take over your CPU cycles. Vista offers a means to ensure that media playback remains a smooth experience even as it balances and juggles these myriad non-entertaining but necessary tasks.

This act of juggling is primarily done through the MMCSS service introduced briefly above. Under Vista, a multimedia application can register itself with MMCSS, telling the service about its multimedia needs on a task-wise basis. This registering happens in the Windows registry under the `HKEY_LOCAL_MACHINE\Software\Microsoft\Windows NT\Currentversion\Multimedia\`
SystemProfile\Tasks key. Vista also exposes the necessary APIs needed to perform this registrations, thus any third-party multimedia application can sign up to the service. The registry key itself defines areas of multimedia usage that an application might require—and defines task and scheduling preferences in keeping with multimedia type. But how does the whole thing actually work? When a registered application is run, MMCSS—which is run at a high priority itself—takes over and boosts the application’s thread into a range indicated by the registry entry, and higher than all other threads running on the system. MMCSS also ensures that such a multimedia application running in the foreground gets 80% of CPU resources. The other 20% are meant to ensure that the entire system does not grind to a stand still while a multimedia application is running. Thus Windows Media Player 11 might assume 8 ms of CPU time over a 10 ms run, while the other 2 ms are doled out to other processes—during this 2 ms of time, the multimedia threads are throttled to lower priorities by the MMCSS service.

### Thread Priorities

| Thread Priorities in Windows range from 0 to 31: thread priorities 16 and higher are in the real-time priority range and higher than all other threads on a system. Only the kernel’s memory manager threads work at higher priorities of 28 and 29. MMCSS runs its priority-management thread at priority 27. |

#### 3.3 File-based Symbolic Links

A feature long present under UNIX operating systems finally makes its presence under Vista: symbolic links. A symbolic link is essentially a pointer to the actual location of a data. Under Windows 2000, directories had symbolic links and were called directory junctions, but it is with the advent of Vista that this concept has been extended to the files themselves. When a user removes the symbol-
ic link, the file or directory to which the link points remains unchanged. Under Vista, changes have been made to commands to include the concept of symbolic links (the DELETE command, for example, does not follow the link to the destination, which would delete the target itself, but deletes only the link).

Symbolic links can be created using the Mklink command—which is able to create both a file link and a directory junction. Under Explorer, symbolic links are identified by the shortcut arrow.

3.4 Cancelling I/O Operations

When an application requires access to the storage media on a system, it launches a series of I/O tasks and requests. The manner in which these tasks work is thus: the application makes the I/O request to an I/O resource in the computer system (say a hard drive). Once the I/O request is granted, the completion of the task is monitored at a port aptly called the completion port. After completing the I/O task, the application’s thread then tells the completion port that its work is done and to wake up any other threads that might require access to the same resource. This is quite a lengthy process, one that requires quite a bit of scheduling and switching. Under Vista, it is not the task which requests the I/O resource that notifies the completion port, but instead the thread that is waiting at the completion port itself that does the completion processing. Thus the interrupting is done by the waiting process and is not necessarily a clean-up task by the thread that requested the I/O. This small change increases the system’s overall performance, especially for a server.

While the above was an asynchronous I/O operation, Vista also changes the way synchronous I/O is handled. Specifically, it allows for better cancellation of synchronous I/O tasks. This is again of great benefit to server systems where each Vista-aware application can now cancel an I/O operation at its own end, instead of waiting
for a network timeout. Applications will of course need to be updated to be Vista-aware, but commands such as “New view” already allow for cancellation of I/O requests (you can [Ctrl] + [C] a net view command if it seems unresponsive).

### 3.5 I/O Priority

While Vista makes allocations to throttle the CPU utilisation of a thread, it would be of little use if the I/O requests were not similarly prioritised and referenced. Say for example, Vista running several background applications such as a disk defragmenter, an anti-virus scanner that scans individual files in the background, an indexing service that indexes disk content for faster service—in this scenario, running a foreground task might bring the system to its knees if the background tasks weren’t properly prioritised. A foreground task should not have to wait for a background task to finish in order to access a disk. Vista thus introduces I/O prioritisation in order to ensure that foreground applications get preference.

Each class of service and application under Vista gets a priority assigned to it. Thus for example, the Memory Manager of the kernel uses the Critical priority when it wishes to flush data from RAM to the hard drive, in order to make space in the memory of the system. I/O in general has a default priority of Medium; priority for applications such as search indexing and Windows Defender scanning use Very Low I/O priority, while most storage devices are given Medium I/O priority.

Apart from I/O priorities, Vista also offers a bandwidth reservation system which ensures a quality of service (QoS) to applications, especially multimedia applications. Under this system, an application such as Windows Media Player, along with MMCSS priority boosts, can deliver nearly stutter-free playback of local content. Such an application would typically ask the I/O system to
guarantee it the ability to read data at a specific rate. If this assurance is possible, the system ensures that the application gets the required access to the I/O systems. This also creates a reservation on the I/O such that the system won’t service other applications until the needs of the multimedia application have been met.

Previous versions of Windows have limited the transaction unit for I/O operations to 64 KB. This means that if an application need to deliver data larger than 64 KB to a disk, it needs to make multiple trips to the I/O system. This puts unnecessary load on the systems involved and adds unneeded overhead for transactions. Under Vista, therefore, this upper limit has been removed, and storage I/O request sizes are no longer capped. Explorer’s Copy command, for example, now issues 1 MB data transactions.

3.6 Memory Management

A 32-bit operating system is limited to addressing 4 GB of memory space. The Windows kernel however, can only access half of that space by default; the other 2 GB is allocated to other threads running on the processor. Within the limited 2 GB, the kernel is require to shuffle various bits and pieces of itself which are vital to the efficient running of the OS—details such as device drivers, file system cache, buffers, and so on.

Prior to Vista, this 2 GB address space was allocated at boot time. Such a preset allocation led to inefficient use of the limited space as some areas required more space post-boot while others were assigned too much of the 2 GB. This, of course, led to application failures and drivers from completing I/O operations.

The 64-bit version of Vista can address far more memory space than the 32-bit counterpart—this number is so high that the practical ceiling will not be reached for a good time to come. The 32-bit version of Vista does face the same ceiling, however. To address
the problem, the Memory Manager under the kernel can now dynamically manage the address space—allocating and de-allocating resources as the workload demands. Thus, the amount of virtual memory used to store paged buffers can grow when device drivers ask for more, and it can shrink when the drivers release it.

3.7 Advanced Features

Windows Vista comes packed with some forward-looking technologies. For example, it can make use of external Flash drives and portable music players as additional memory to boost the performance of a system. Vista also offers an advanced caching system which caches frequently used programs to memory such that future launches of these programs are significantly faster. While these features are internal to the OS itself, Vista also offers an innovation in the form of Windows SideShow which will help take personal Windows data and relevant information to external devices such as phones and laptops. Let’s take a look at some of these new and advanced features of Vista.

3.7.1 Memory Priorities And SuperFetch

Here’s a fairly common scenario under older versions of Windows: let’s say you were working on some vital data, say a particularly complex worksheet under Excel, and decided to take a lunch break. While gone, let’s assume that an anti-virus program is triggered to scan your hard drive as part of a screensaver, or even as a scheduled task. When the anti-virus is triggered, it might request the system to give access to more memory than is currently available. Under this scenario, the system will flush all data associated with your Excel work to the hard drive and free up memory for the anti-virus program. Now, when you return to your Desktop and try to resume your work, you are likely to notice performance degradation: Excel will take a long time to restore to full screen, for example, while the entire system gets busy freeing the necessary space in memory.
to allocate once more to Excel. This is usually associated with thrashing of the hard drive: your system steadily blinks a red light to indicate constant disk access.

Scenarios such as this are usually due to inefficient memory management. Vista aims to eradicate, or at least alleviate these issues to a large degree by implementing memory priorities, just as it does with I/O priorities.

Memory is cached by the system in a buffer called the Standby List in the form of “pages.” When a program requests memory from the system, the system creates a new page at the beginning of the Standby List with the help of the kernel’s Memory Manager. When the program is done using the memory space, its allocated page is cached to the end of the Standby List—if the program wants to access the page again, the Memory Manager is called to reassign the page to the program.

Under Vista, each Standby List is further divided into eight parts based on priorities: thus every page of memory has a priority in the range of 0 to 7. The page inherits the priority from the program or thread that creates the page. Such a Standby List which is arranged by priority is then used by the Memory Manager to better anticipate future memory calls of an application and to thus make allowances for each application based on its historical usage. To better understand how this happens, we need to take a closer look at how SuperFetch works.

SuperFetch is a memory management scheme which is used to predict memory requirements of an application based on its historical usage of such resources. SuperFetch makes application launches quicker as time passes. It does so by tracking which applications you often launch, and at what time, etc. and then using this historical information to preload parts of the frequently-used programs into memory, thus ensuring that future sessions of the application start faster.
The scheme relies on support from the Memory Manager to retrieve page usage histories. It also calls on the Memory Manager to preload data and code from files on disk or from a paging file into the Standby List and assign priorities to pages. Thus it might pre-fetch code from Adobe Photoshop, such that when you launch Photoshop, it is started much faster than before.

When an application exits and frees up memory, SuperFetch asks the Memory Manager to fetch the applications associated data and code which is going to be flushed from the memory proper. This data is then stored by SuperFetch, such that when you need to resume a program, SuperFetch can bring all or most of it back into memory. Going back to our scenario with the anti-virus: SuperFetch would store the data and code of the Excel sheet when the anti-virus application is launched. It would also make sure that most of that code and data is back into memory before you return.

SuperFetch extends this support to other aspects of the system as well, aspects such as Hibernation and Fast User Switching. For hibernation, SuperFetch stores data and code in the hibernation file that it expects (based on historical records) will be accessed during the subsequent resume. In contrast, when you resume Windows XP, previously cached data must be reread from the disk when it is referenced.

### 3.8 Reliability, Security, And Power Management

#### 3.8.1 ReadyBoost

On a typical system, I/O operations take a significant chunk of overall system processing. A hard drive read or write is almost as frequent as CPU to memory transfers. This highlights one of the biggest bottlenecks of our computer systems—hard disk access times. When compared to the speed at which the rest of the system operates—the processor, the memory system (RAM), the video
card, and communications between the various chipsets on the motherboard—the hard drive with its 10 ms seek times (on average), seem prehistoric; a snail’s pace in a jet age.

To alleviate this bottleneck, Vista introduces another layer of storage between the fast (yet expensive) RAM, and the slow (yet inexpensive) hard drive. This layer is that of the Flash memory: Flash is cheaper than RAM, but faster than the typical hard drive by a factor of 10, thus it makes for a good in-between solution.

Vista thus makes use of any Flash device as a system cache, in lieu of the traditional hard drive cache. The idea is that the Flash cache is given priority if available and thus system bottlenecks are much reduced.

This feature of Vista falls under the banner of ReadyBoost. ReadyBoost is of course only used if there is a Flash device present—while some motherboard will soon sport minimal Flash storage devices in the near future, currently this would largely be limited to your music player or to a USB drive.

So how does ReadyBoost work? Firstly, the Flash device should be between 256 MB and 32 GB in size, with a transfer rate of 2.5 MB/s or higher for random 4 KB reads, and 1.75 MB/s or higher for random 512 KB writes. When you insert such a device, Vista asks if you would like to dedicate up to 4 GB of the disk for the purpose of data caching. Note that the 4 GB is purely for the benefit of FAT32 devices... if you agree, a caching file named ReadyBoost.sfcache is created in the root of the device. SuperFetch then repopulates this cache in the background and then triggers the Ecache.sys device driver to intercept all reads and writes to local hard disk volumes. The data is then written into the cache file with a compression ratio of 2:1. Thus the 4 GB cache can typically store up to 8 GB of actual data. The data stored is also encrypted using Advanced Encryption Standard (AES). The key for encryption is randomly generated per-session in order to guaran-
tee privacy of the data. While ReadyBoost allows caching to such a Flash drive, all I/O access to the cache need not necessarily go to the Flash cache. For example, if a cache call requires a sequential read access, ReadyBoost will direct the call to the hard drive, instead of the cache on Flash. This is because hard drives are faster at sequential reads than are Flash drives. Random reads, however, are satisfied from the Flash cache.

Another positive implication of ReadyBoost is to laptop owners—Flash access is less costly in terms of battery life than access to a hard drive. This should, in theory, increase battery life of a laptop.

3.8.1.1 Turning ReadyBoost on or off for a storage device
When you insert a compatible portable device, the AutoPlay dialog box will offer you the option to speed up your system using Windows ReadyBoost:
1. Plug a Flash drive or other removable media device into your computer. This should automatically open AutoPlay
2. If AutoPlay does not open, it might have been disabled.
   • To enable AutoPlay click on Start > Control Panel and type ‘auto’ in the search box in the upper-right corner. Then click on the ‘Start or stop using auto-play for all media devices’ and then click on the ‘Use AutoPlay for all media and devices’ check box
   • You can also enable ReadyBoost by right-clicking on your portable device inside Windows Explorer
3. In the AutoPlay window, under the General Options, click ‘Speed up my system’
4. This will display the Properties dialog box for your Flash drive or other removable media device.

5. Click the ReadyBoost tab, and then do one of the following:
   - To turn ReadyBoost off, click ‘Do not use this device’
   - To turn ReadyBoost on, click ‘Use this device’, and then move the slider to choose how much of the available space on your Flash drive you want to reserve for boosting your system speed.

6. Click OK.

The removable device must contain at least 256 MB of free space to work with Windows ReadyBoost. The recommended amount of memory to use for ReadyBoost acceleration is one to three times the amount of RAM installed in your system. If your PC has 512 MB of RAM and you plug in a 4 GB USB Flash drive, setting aside space between 512 MB to 1.5 GB on that drive will offer the best performance boost.

### 3.8.2 ReadyDrive

Recently announced were hybrid disk drives which were part non-volatile Flash memory (NVRAM) and part regular hard disk. Such H-HDDs, as they are called, should soon become regular features of our computer systems. Typically, H-HDDs include between 50 MB and 512 MB of Flash memory. Much like ReadyBoost, Windows Vista will make use of this Flash capacity to store frequently used data as cache. Vista can, for example store boot data to the cache when the system shuts down or hibernates. This should allow faster restarting or resuming, respectively. The cache can also be used as a scratchpad for data reads and writes even when the hard drive has spun down—this should reduce the power consumed by the disk under normal usage; once again a plus point for laptop owners.

### 3.8.3 ReadyBoot

When a Windows system boots, a large number of files need to be read into memory and processed. Typically, the files which need to be called upon boot depend on which services and startup programs the user requires to start the system up. This process can be
quite inefficient since multiple portions of the same file may be accessed at different times during bootup.

To reduce this inefficiency, the system can cache data that is frequently called upon during the boot process. Practically, code and data accessed during boot are traced by the system (ReadyBoost in this case) and the information is recorded as a cache file. ReadyBoot is, incidentally, implemented by the ReadyBoost service described earlier. ReadyBoost will continue monitoring the system for 90 seconds after start of the boot, or until 30 seconds after the shell has started, or until 60 seconds after all services have been initialised, whichever elapses first.

ReadyBoost uses idle CPU time to calculate a caching plan for the next boot based on historical data it has collected as trace information from the previous boot (typically information pertaining to which files were accessed and where they are located on disk).

The size of the cache depends on the total RAM available, but is large enough to create a reasonable cache and yet allow the system the memory it needs to boot smoothly.

### 3.8.4 Windows SideShow

If there is one thing that’s in abundance in this wired world, it’s the presence of displays of various shapes and sizes. LCD panels, in particular, seem to be everywhere—from our keyboards, to our music players, to even our speaker systems. So why not extend and enhance the use of these panels to serve and bring us disparate information?

This is the essence of the SideShow idea. SideShow as a concept calls for a marriage between hardware and a new feature introduced into the Windows ecosystem—that of gadgets. A gadget under Vista is essentially a mini-application, generally built to perform a single task. For example, a gadget that will bring your RSS feeds, or another that will display the weather information, a third might collate all
your instant messenger buddies into a single list, and so on. Such
gadgets can be found residing on the Sidebar or the Desktop of Vista.

A SideShow device can pull in data from your Windows Vista
system and display it separately. A SideShow device might use
gadgets to do this, or it might create programs all its own. For
example, you might purchase a laptop in the near future which
might have a small SideShow LCD window on the lid of the lap-
top. This window can be used to display information on your
email, or battery life remaining, or even the time of the day.
When the host machine is turned off, the data viewed on the
SideShow display is not the latest data but a cached version of
your inbox, or contact, etc. When the machine is powered on
and online, the SideShow display will have real-time data.

Such a device can come in handy in determining important
data (such as new mails or appointments), at a glance. A SideShow
enabled device can also be a desktop clock sitting next to your PC, or a cell phone, or even a watch.

3.8.5 Some possible SideShow devices:
Integrated devices on laptops. If your laptop has an integrated Windows SideShow-compatible device, you can view your Windows Mail inbox without opening the lid or turning on the computer.

Mobile phones. With Windows SideShow, you can configure a compatible mobile phone to show you your contacts and calendar and other information.

Remote controls. While you watch TV with your family on Windows Media Center, you can find out what programmes are showing next or schedule a recording for the next day. You can also browse through your Windows Media Center music collection from the display on the remote control without turning on the TV.

Devices which are SideShow capable will sport an appropriate logo. SideShow devices appear under the Control Panel—go to Start > Control Panel > Hardware and Sound > Windows SideShow. From here, you can set your computer to wake periodically such that all gadgets that are turned on can update your devices with the latest information.

The Vista kernel has brought in several changes to the way applications and services are handled. Changes have also been made to bootup and shutdown processes; the Boot.ini file, for example, is out of Vista. This chapter should have helped you understand just how deep the changes to the system go. In the next chapter, we will take a closer look at the changes made to the interface. We shall also take a quick look at the various applications that Vista bundles along.
After that quick peek at what lies beneath, let’s take a look at some of the new features of Vista that are more readily visible. Some of these features and programs are also in Windows XP, but their Vista counterparts generally add a feature or two to make them ever so slightly different.
4.1 Authentic, Energetic, Reflective, and Open (AERO)

Yes, Aero is actually an acronym that stands for the above. With that ridiculous detail out of the way, what else does the interface bring to the table?

Vista’s Aero interface did not make its appearance until some time into the development process. The Windows development team wanted to create an experience around the interface, instead of just a bunch of buttons—to this end, several elements that talk and interact with the user were designed and integrated. As an example, the sounds used by Windows Vista were recorded and engineered to extend the Aero experience; as Jim Allchin put it on his blog, “The Windows XP sounds were not consistent with the interface design goals of Windows Vista, so we overhauled the sounds to complement and blend with the softer, cleaner Windows Aero Glass...
theme and user interface elements for Windows Vista.” The new sounds were collaboration between Robert Fripp, Tucker Martine, and Steve Ball, and aimed to leverage the visual cues of the Aero interface through audio: “Just like the visual cues of the new Start button, the audio cues of the new sounds are ‘rounded’ and ‘translucent’.”

4.2 The New Start Menu

That “rounded” and “translucent” extend to all the aspects of the new interface. The most visible element to have undergone this change is the new Start button that leads the Vista taskbar. The button no longer carries the “Start” label: it is now spherical and glass-like in appearance, and is fittingly referred to as the “Orb” or the “Pearl.” Clicking on the Orb reveals the second major change to the taskbar—the Start Menu has been completely overhauled with a much greater emphasis on searching for the program or document you’re looking for. This change is not always welcome: instead of being able to launch applications directly from the Start Menu by typing out their first letters, the typing now triggers a search. This process is usually a second or two slower than the previous method of launching applications. This also implies that hot-buttons are no longer valid for the Start Menu. For example, while you could highlight the My Documents folder under Windows XP by pressing and releasing the Windows key and then [D] on your keyboard; the same process will trigger a
search beginning with the letter D under Vista—this thus puts a greater emphasis on the mouse to open different elements on the Start Menu. However, this would only be noticed by experienced users and the new search field does help more than it hinders, especially since it can search documents and recently-opened items as well.

The second change to the Menu is that the “All Programs” item no longer triggers a separate menu, but opens in the same space as the left portion of the Start Menu. This avoids the endless menu navigation of the old method, and the reliance is now on scrolling up and down for programs. Yet again, this new method might prove a hindrance to users used to the old menu style.
The final functional change is to how Windows shuts down—by default, it doesn’t. Vista goes into a low-power state, wherein your work is saved to disk—the default behaviour is thus the Sleep mode as seen under XP. This has been done to reduce startup times, as it is much quicker to boot the OS from Sleep mode than a cold restart. To access the traditional Shutdown command, you need to dig a bit deeper into the menu by clicking on an arrow right next to the “Lock” icon—this reveals all the methods for powering down or locking your computer: Switch User, Log off, Lock, Restart, Sleep, and Shutdown.

Visual changes have also been made to the taskbar structure, which extends beyond the Orb. The most striking is the use of
translucent elements: on startup and under normal use, the entire taskbar remains translucent, showing you the Desktop in the background. This behaviour changes when an application is maximised, when the taskbar becomes completely visible. The translucency also extends to the Start Menu (or the Orb menu, if you will)—one can just make out the background window, slightly blurred, or the Desktop when the menu is triggered. Some amount of animation is also used on the Start Menu, particularly for the area where Vista shows the user’s display picture. This user icon animates to show iconic representations of the user’s documents folder, the pictures folder, his or her computer, and so on.

Other major changes have been made to the system clock and the volume control, both of which reside in the tray of the Vista taskbar. The system clock finally displays a calendar view when clicked, along with an analogue clock showing the time. The calendar allows you to browse through months, one at a time, or to zoom out to a month view, a year view, and a decade view, if you so wish. The clock can also display information from two other time zones, and is synced once per day to an Internet clock—a boon for the travellers.

The volume control is now capable of offering
control options for individual programs, apart from an overall master control. This is due to changes made to Vista’s audio system, as noted in the previous chapter. What this entails is that you can now set your audio player of choice at full volume, while your instant messenger at a significantly lower volume—this prevents message alerts from blaring full blast in the middle of a Beethoven symphony.

4.4 Exploring Vista

Vista offers a significantly different shell in the form of Explorer compared to XP. Both visible and under-the-hood changes have been made to all manner of windows—be it a window to explore your drives or a dialog box to open or save a file under an application.

Let’s start with the Explorer first. Vista has gotten rid of the menu bars of old—no more File, Edit, View, Help menus to be found by default. (This setting can be changed by selecting Organize > Layout > Menu) Also present on all major windows and Wizards is a Forward and Back button reminiscent of the ones found on Web

Details are easily viewable in the Status Bar
browsers. These buttons are seen everywhere in Vista from Explorer windows to Wizards. The default Explorer view now shows a much larger status bar, one that is able to showcase a lot more information around a selected file or a folder. For example, the status bar can be used to insert meta-tag information to certain filetypes—the new XPS format, for one. One can also enable a preview pane under explorer. The pane does as you might expect it to do: you can use it to preview multimedia files—video files, for example, can be played in this pane; contents of text files are directly displayed.

The new Explorer also introduces some navigational changes.

The left-hand pane is now split into two uneven parts—a smaller window on top shows the most common places that you explore, such as your Documents or Pictures folders. Just below this pane is a slightly more traditional tree view of your computer; incidentally, the lower pane can be hidden from view by collapsing it. The most useful navigational element is again a borrowed metaphor from the Web, much like the back and forward buttons—this is the
concept of breadcrumbs as navigation tools. A breadcrumb is used to denote a path to a particular directory or file. They are extremely useful as navigation aids: they not only show you where you currently are, but also denote the path you took to get there. Thus you can backtrack or head to another place on a system by following these “crumbs.” These breadcrumbs make navigation much simpler and is one of the first features you will miss going from any other OS to Vista.

The new Explorer also offers a context-sensitive taskbar on top. The taskbar offers options to the user depending upon what the user has selected—a file or a folder. For example, selecting an HTML file will reveal an “Open” button which when clicked will open the file in the default application; the button also offers a drop-down if more than one application is able to open the file type—for the specific example of an HTML file then, you would get the options to open it in Internet Explorer, or Firefox, or Opera, and if you have the programs installed, even an HTML editor. Apart from this one task of opening an item, the context-sensitive bar also offers options for printing the file, or e-mailing the file, or even burning the file to CD or DVD.

The biggest addition, however, is that of the Search tool. You can trigger a system-wide or a local search from almost everywhere under Vista. By default, Vista indexes your personal folders and e-mails, and exposes them under the Search tool. This can, of course, be changed easily; indexing, however, cannot be turned off. The Search window is present in the upper right-hand corner of each Explorer window and also in common dia-
log boxes, such as the Open filedialog. Searching is quick and is exposed by default as a simple query, which can, however, be extended to search on the basis of multiple variables such as filename, tags, authors, location, date, size, and whether the search should extend beyond the indexed locations.

Also available is a Search Pane, which offers quick filtering options to the search results on the basis of file types. Thus, if you run a search on “kitten”, the tool will return all results under your indexed locations—you can then filter the results by clicking on “Picture”, which will only show pictures with the term “kitten”, or alternatively choose to show only e-mails exchanged with the word kitten in them by clicking “E-mail”, and so on.
4.5 Something Old, Something New

Changes under Vista are not limited to the Explorer; new programs have been added, and new features added to regulars. Some have been dropped altogether, while others no longer enjoy a high level of integration with the operating system. Let’s take a look at each of these programs separately.

4.5.1 Windows Sidebar

The concept of widgets has been around in one form or another wherever operating systems were to be found—be it the *nixes or the Windows, or indeed the Macintosh environment. Under Windows, specifically, this author recalls that Stardock had long ago introduced a concept quite similar to the now-prevalent Widgets. Vista introduced the Sidebar under the then-codenamed Longhorn build released in September 2002. While many have suggested that Vista borrows the idea from Konfabulator (now Yahoo! Widget Engine) or from Apple’s Dashboard, it is interesting to note that both these programs were introduced after September 2002. What, then, is a widget? The simplest explanation is that it is a mini-program—one stripped to the most rudimentary features. For Vista’s implementation of the widget concept, we can think of them as simple tools written in HTML/XML markup languages.

The Windows Sidebar is a simple panel that gathers several of these widgets—which are called Desktop Gadgets under Vista—into a single interface element. The concept of the Sidebar originated from an internal Microsoft research in 2000. The Windows Sidebar is essentially meant to display quick information on various aspects of your social or online life. For example, a Gadget might be used to display RSS feeds off your favourite Web
site, another to display the latest e-mails, yet another might visually show the phases of the moon, while one might be used to track and show ticker prices on stocks. These Gadgets can reside on the Sidebar or as free-floating elements on the Desktop. The Sidebar itself can be placed at various places around the Desktop; it is even multi-monitor aware and can be placed on a second monitor if real-estate is prime on your primary display. All in all, the Windows Sidebar is a nice addition to the operating system; however the addition of Yet Another Widgetised Sidebar seems unnecessary in the light of similar options from Yahoo!, Google, Stardock, Desktop Sidebar, et al. Longhorn might have been the first to showcase the concept, but the road to Vista has been so long, the Windows Sidebar seems to have been too late to arrive.

However, it should be noted that integration of a feature into an OS is in no way comparable to an external, third-party tool: the Windows Sidebar will boost the development of widgets at best, and will encourage already-developed widgets to be migrated as Gadgets, at worst. Stardock, for example, has already made public its intention of leveraging its current Widget inventory and know-how to make Gadget creation and porting easier.

Head to gallery.live.com to browse through an already-impressive array of Desktop Gadgets.
4.5.2 Internet Explorer 7

The latest version of the most-widely used Web browser was first made available under Windows XP. The browser brings several changes and feature additions—long overdue—to the table. The most important point of difference between the IE7 implementation under XP and Vista is that for Vista, IE7 is not integrated into the operating system, as Internet Explorer was for previous versions of Windows. IE7 under Vista runs in a protected mode, wherein it is separated from the rest of the system; exploits and malicious content are prevented from writing to any other part of the system (except the Temporary Internet Files) without explicit user consent. IE7 can also be launched without any add-ons or ActiveX controls—all third-party toolbars are also disabled in this mode.

Apart from these security measures, IE7 introduces an RSS feed discovery icon and a feed reader. The discovery icon is greyed and disabled while browsing a site that doesn’t offer content syndication, while it activates to a bright orange if it stumbles upon an RSS feed. The feed reader is quite capable—offering a standard newspaper layout, alongside a search utility and some filtering options based on date, author, and title.

Interestingly, any feeds added through Internet Explorer 7 are added to a Common Feed List—an OS-wide repository for RSS feeds. Thus a feed can be visible under more than one supported program. For example, feeds added through IE7 are automatically made visible in the RSS feeds Gadget found in the Windows Sidebar; unfortunately, this is the only means of adding an RSS feed to the Sidebar Gadget for now.
Others features added to IE7 include support for tabbed browsing, page zoom which now zooms the entire page (and not just text as in previous versions), quick tabs (thumbnail representation of open tabs), a phishing filter, a pop-up blocker, and improved Web standards support including support for PNG alpha channel. An overhaul of several of the underlying technologies was also made to increase both security and Web rendering performance.

4.5.2.1 IE Settings

Settings for IE can be found and modified here. You also have quick access to the tasks of: changing your IE security settings, or deleting browsing history, or even managing your browser addons. Clicking on Internet Options will open the Internet Properties window which offers several options under multiple tabs:

**GENERAL:** The first tab allows you to set up a single home page, or multiple home pages; since Internet Explorer now supports tabbed browsing, you can set up more than one home page. You can also delete your browsing history here. Note that unlike previous versions, you do not have to delete cookies and cache separately. Clicking on Settings here will allow you to change the cache size and its location. Other options in the General tab include a Search field which allows you to change the default search engine that IE uses, a Tabs field which allows you to change the way tabs behave under IE, and finally the Appearance field through which you can change font and colour behaviour under IE.

**SECURITY:** The second tab is where you can change the security levels or zones for IE. Each zone is for a particular network scenario and offers different settings for aspects such as ActiveX downloading (allow, or prevent, for example). You can change any of these pre-set settings by clicking on the ‘Custom level...’ button.

**PRIVACY:** The third tab which is somewhat related to the Security tab, in that it carries off some security options itself. As with the Security tab, the Privacy tab offers several zones which define the level of privacy settings that apply to IE. The zones here,
offer settings which modify the manner in which cookies are handled by IE. Privacy tab also offers access to the in-built Pop-up Blocker of IE. Here you can turn on or off the Blocker and change its settings.

**Content:** The fourth tab allows access to web content based on several settings which are offered here. The very first element is that of Parental Controls, which as you can imagine, offers parental control over browsing behaviour: you can allow or block websites, maintain a time table for Internet browsing and so on. The Content Advisor here, allows you to set certain criteria for websites which you want to browse (or want a minor to browse). When enabled, Content Advisor compares the Web site against the criteria that are configured in Content Advisor. The Web site will be displayed only if it meets or exceeds the criteria. The criteria that are configured in Content Advisor can be ratings criteria, lists of approved and disapproved Web sites, or both. If ratings criteria are used (that is, if any rating settings other than ‘Unrestricted’ are used), by default, sites that are not rated by the chosen ratings system cannot be viewed. Ratings criteria include options such as “Content that sets a bad example for children”, “Depiction of alcohol use”, “Depiction of drug use”, “User-generated content”, “Violence”, “Nudity”, and so on. By default, the rating system used with Content Advisor is the Internet Content Rating Association (ICRA). This tab also offers the Feeds option which is the RSS reader added to Internet Explorer 7. Here you can set when to check for new feeds, and other reading options.

**Connections:** The fifth tab offers options that IE can use to connect to the Internet.

**Programs:** Here you can determine whether IE is the default web browser. You can also manage any add-ons that you might have added to IE. An add-on can be an ActiveX control, a browser extension, or a browser helper object. You can enable or disable any or all such add-ons here.
**ADVANCED**: The final tab, offers a multitude of settings and options which determine a wide range of behaviour for IE. These are categorised under broad heading of: Accessibility (where you can set the default zoom level for example), Browsing (where you can disable third-party plugins, for example), HTTP 1.1 settings, Java settings, Multimedia settings (you can enable ClearType independently of the system here), Printing, Search, and Security. The final option of Security offers controls over the Phishing Filter of IE, apart from other settings.

### 4.5.2.2 Managing Add-ons

Web browser add-ons add features (for example, extra toolbars, animated mouse pointers, stock tickers, and pop-up ad blockers) to your web browser.

**To see which add-ons are installed on your IE browser:**

1. Start Internet Explorer
2. Click **Tools > Manage Add-ons > Enable or Disable Add-ons**
3. In the Show box, select one of the following options:

   - To display a complete list of the add-ons that reside on your computer, click ‘Add-ons that have been used by Internet Explorer’
   - To display only those add-ons that were needed for the current webpage or a recently viewed webpage, click ‘Add-ons currently loaded in Internet Explorer’
   - To display add-ons that were pre-approved by Microsoft, your computer manufacturer, or a service provider, click ‘Add-ons that run without requiring permission’
   - To display only 32-bit ActiveX controls, click ‘Downloaded ActiveX Controls (32-bit)’

You can either temporarily turn off add-ons, or permanently remove them from IE. Note that some web sites might not display correctly if an add-on is disabled, and thus disable one only if it is persistently causing problems.
Temporarily Disable All Add-ons
Go to Start > All Programs > Accessories > System Tools, and then click Internet Explorer (No Add-ons). Alternatively you can search for ‘in ad’ in the Start menu’s search box and launch Internet Explorer (No Add-ons). IE will now in a session without any add-ons.

To Permanently Disable Add-ons
1. Start Internet Explorer
2. Click Tools > Manage Add-ons > Enable or Disable Add-ons
3. In the Show list, click ‘Add-ons that have been used by Internet Explorer’ to display all add-ons
4. Click the add-on you want to disable, and then click Disable
5. Repeat step 4 for every add-on you want to disable

4.5.2.3 Tabbed Browsing
Tabbed browsing is a new feature in Internet Explorer that allows you to open multiple Web sites in a single browser window. To open a new tab, click on the New Tab button inside IE, or press [Ctrl] + [T]. You can browse between tabs by clicking on the tab or by using the Quick Tabs button in IE. Quick Tabs provides a thumbnail view of all your open tabs and can be started by clicking on the Quick Tabs button or by pressing [Ctrl] + [Q]. When you click on the arrow next to the Quick Tabs button a list of all the websites that you have open is displayed. To switch to a site displayed in the list, click the site name. Click the Quick Tabs button to close the thumbnail view and return to the last page that you were viewing.

KEYBOARD SHORTCUTS

Keyboard shortcuts for tabbed browsing
Open links in a new tab in the background → [Ctrl] + left-click
Open links in a new tab in the foreground → [Ctrl] + [Shift] + left-click
Open a new tab in the foreground → [Ctrl] + [T]
Open a new tab from the Address bar → [Alt] + [Enter]
Open a new tab from the search box → [Alt] + [Enter]
Open Quick Tabs (thumbnail view) → [Ctrl] + [Q]
Switch between tabs → [Ctrl] + [TAB] OR [Ctrl] + [Shift] + [TAB]
Switch to a specific tab number→
[Ctrl] + [n] (n can be 1-8)
Switch to the last tab→
[Ctrl] + [9]
Close current tab→
[Ctrl] + [W]
Close all tabs→
[Alt] + [F4]
Close other tabs→
[Ctrl] + [Alt] + [F4]

Mouse Shortcuts For Tabbed Browsing
Open a link in a background tab→
Click the middle mouse button on a link
Open a new tab→
Double-click the empty space to the right of the last tab
Close a tab→
Click the middle mouse button on the tab

4.5.3 RSS Feeds and Page Zooming
A feed, also known as RSS feed, XML feed, or syndicated content, is website content that can be automatically delivered to your browser. By subscribing to a feed, you can get updated content, such as breaking news or new posts added to your favourite blog, without having to visit the website. The Feeds button in the Internet Explorer toolbar will light up when a feed is available for a webpage you’re viewing. Click the button to display the feed or to subscribe to it.

Along with a feed reader, IE also introduces a Zoom facility with this version. Page Zoom lets you enlarge or reduce the size of a web page. Unlike the previous version of zoom, which changed only the font size of the page, the new zoom enlarges or reduces everything on the page be it text or images. You can zoom from 10% to 1000%. To zoom in or out of a page, click on the Zoom button which is located in the lower right-hand corner of the screen. By clicking on the Zoom button, IE will step through three zoom levels: 100%, 125%, and 150%. You can also access other zoom levels by clicking on the small arrow next to the Zoom button; note here that you can also specify a custom level of Zoom. You can also zoom into a web site by pressing <Ctrl> + <-> and zoom out by pressing <Ctrl> + <>. You can also hold down the Ctrl button and use the mouse wheel to zoom into and out of a web page.
4.5.4 Adding Search Engines

The new Instant Search box lets you search the web from the Address bar. You can also search using different search providers to get better results. By default, IE uses the Live search engine but this can be easily changed to a search engine of your choice:

1. Open IE. The search box is situated in the upper right-hand corner of IE
2. Click the arrow to the right of the search box
3. Click Find More Providers
4. Click the search providers you would like to add. This opens the Add Search Provider dialog box
5. If you want the provider that you just added to be used by default when searching from the Address bar or search box, select the ‘Make this my default search provider’ check box
6. Click Add Provider
7. Repeat steps 4 through 6 for each provider you want to add

4.5.5 Phishing Filter

Online phishing (pronounced like ‘fishing’) is a trick used by malicious web sites to get you to reveal personal information about yourself. Phishing is generally done through a web site or an email message and the personal information gathered from Phishing is used for financial fraud. According to Microsoft, “a common online phishing scam starts with an e-mail message that looks like an official notice from a trusted source, such as a bank, credit card company, or reputable online merchant. In the e-mail message, recipients are directed to a fraudulent website where they are asked to provide personal information, such as an account number or password. This information is then usually used for identity theft.”

The Phishing Filter in Internet Explorer helps detect websites that are either known to indulge in phishing or are acting suspiciously similar to a phishing site. The filter runs in the background while you browse the Internet and uses three methods to help protect you from phishing scams:
1. It compares the addresses of websites you visit against a list of sites reported to Microsoft as legitimate. This list is stored on your computer.
2. It helps analyze the sites you visit to see if they have the characteristics common to a phishing website.
3. With your consent, Phishing Filter sends some website addresses to Microsoft to be further checked against a frequently updated list of reported phishing websites.

If a site that you are browsing is suspected of being a Phishing site but isn’t on the list of known phishing sites, IE will notify you about this in its Address bar. If, however, the site you are visiting is on the list of reported phishing websites, Internet Explorer will display a warning webpage and a notification on the Address bar. You can then continue or close the page.

To turn Phishing Filter off
1. Start Internet Explorer
2. Click Tools > Phishing Filter > Phishing Filter Settings.
3. Scroll down to the Security section and find the Phishing Filter entry, click Disable Phishing Filter, and then click OK.

To turn on Phishing Filter
1. Start Internet Explorer
2. Click Tools > Phishing Filter > Turn On Automatic Website Checking
3. Click ‘Turn on automatic Phishing Filter’, and then click OK.

**4.5.6 Windows Media Player 11**
Windows Media Player 11 is another program that Microsoft has released on both Windows XP and Vista. Under Vista, WMP11 offers a few additional features, including the ability to share your multimedia library (playlist and catalogue sharing) with another Vista user over a network. Generally speaking, WMP11 brings along a new interface to catalogue, search, and play your media content—music, videos, or photos. It also introduces an integrated search feature that filters your content as you type keywords.
Media can also be rated, and album information or media information can be fetched from online servers and automatically pasted into your media.

The most important change that the software brings is that media can now be browsed through a much more visual thumbnail view, rather than through a simple text interface. Music albums, for example, are represented by their cover art (which can be fetched from servers as mentioned); videos automatically generate their own thumbnails. Most media can now be “stacked” based on genre, year of release, artist, and so on. For example, all albums from one artist can be stacked as a single unit, or all albums under the genre Jazz, and so forth.

Media browsing follows the breadcrumb interface and media is automatically arranged by genre, year, artist, ratings, and even as recently added.
Your favourite media players might not play nice under Windows Vista. Specifically, most of the players out there force Vista to throttle down the Aero interface to the plain Vista Basic. Players that have been known to do this include VLC player and Media Player Classic. We recommend using the GOM player from Gretech Corporation (www.gomplayer.com): it is freeware and comes pre-installed with most of the codecs you might need to play your videos. You can always revert to the program of your choice once Vista support is added.

### 4.5.7 The Backup and Restore Center

Vista offers several routes to protect and backup your data. As in Windows XP SP2, you can create a restore point and then go back to it at a future date (points are automatically created as seen fit by the OS). System Restore is like an OS-level undo feature which allows you to roll back on system-wide changes—be it through software installs, driver updates or OS updates—without affecting your personal files, such as email, documents, or photos. Restore points can be created across hard drives through the System Protection feature. While this is a system-level feature, Windows also offers data protection under the new Backup and Restore Center.

This feature offers the user options to back up relevant data to a variety of media. A backup can be scheduled at periodic intervals. Backing up is done incrementally, which means that successive runs of the software will only add information that has been changed to the user’s data, minimising the space required for the backup, as also the time required to make additional backups. The Ultimate, Business, and Enterprise versions of Vista also offer a
“Complete PC” backup, which essentially creates a disk image of your entire computer that can then be saved on a hard drive, on network storage, or burnt to DVD. The Complete PC restore can also be initiated from the Windows Vista installation disc in the event of PC failure.

Backup files are exposed as “Previous Versions” under Vista. Right-clicking on any file will show a new option under Vista labelled “Restore previous versions”—it is here that you will find older versions of that particular file which can then be easily restored. A Previous version of a file can either be a backed-up file or a shadow copy of a file. A shadow copy is created by the System Restore feature of Vista, while, as we just saw, backups are taken by Backup and Restore. Shadow copies are automatically created by Windows Vista as part of the System Restore process, when it a Restore Point is created. Notable here is that the ability to create shadow copies of a file are not supported under the FAT and FAT32 file systems, thus System Restore does not extend protection to FAT and FAT32 disks.

If you use Disk Cleanup to remove Restore points, you will also lose shadow copies of your files.

4.5.8 Windows Mail
This is the replacement for Outlook Express under Vista. However, some features have been dropped from Windows Mail such as support for WebDAV (a protocol that allows users to collaboratively edit and manage files on remote web servers) and integration with Messenger. The program also lacks integration with Windows Calendar. Finally, Windows Mail no longer supports multiple identities within one running instance of the program. Multiple identities are used to set different properties and options under the program—say one for office use, which uses IMAP to fetch mails, and another for a roaming account, which might be a POP access. Such identities are now tied to the user account and in order to create a new identity, one needs to create a new user account under Windows Mail.
Apart from some minor interface changes to integrate the program better with Vista, Windows Mail also offers some behind-the-scene changes to the way mail is stored. Mail messages are now stored as individual files instead of a single file as under Outlook Express. Such a structure allows for real-time searching of data and improves the stability and the reliability of the stored data. Account setup is also no longer stored in the registry but is stored alongside the mail, which makes migration of the entire mail repository and settings a much simpler task. Windows Mail also adds the anti-phishing filter seen in IE7; it automatically scans a Web site against a list of malicious sites and informs you if you're at one of those. Windows Mail also includes a junk-mail Bayesian filter to minimise spam. (A Bayesian filter can be trained in accordance with a user's needs and requirements and essentially “learns” to identify messages that a user finds useless as spam.)

4.5.9 Windows Calendar
This is a simple calendaring and task scheduler bundled with Vista. The program allows for simple appointments and tasks; an appointment can be tagged with location, a URL, and recurrence options. You can also set reminders to an appointment and speci-
fy other people who need to be part of the appointment—as attendees. Attendees are imported from Windows Contacts. Apart from appointments, you can also set up tasks under Windows Calendar. Tasks are set similar to a new appointment and can be attached with notes as well. An important feature here is that Windows Calendar supports subscription to an online calendar via the iCalendar or iCal standard. This allows users to send meeting requests and tasks to other users through emails. Users of Windows Calendar can respond to the sender easily or propose a different time or venue for the meeting.

4.5.10 Windows Photo Gallery

The Photo Gallery is a photo management and retouching tool which both catalogues and offers minimal and beginner-level photo retouching options. It is ideally meant to be used by amateur photographers who need a tool to import and manage photographs. The tool supports categorizations based on tags and even extracts tags from the EXIF data created while taking a snap. (EXIF is a specification used by cameras to store data on the photos taken. This can be date and time information, as also camera settings such as aperture, ISO speed, and focal length. EXIF also stores other data on the photo such as a thumbnail of it, copyright information, and so on.) Windows Photo Gallery offers a search feature that searches on keywords and tags; it also allows adding of captions to photographs, as well as rating each photo over five stars.

Photographs can be browsed on the basis of tags—either auto-generated or manually input—or via date taken, ratings, or the more traditional folder route. Windows Photo Gallery also
automatically generates a Table of Contents based on date or tag or ratings; indeed, based on any method offered for browsing content. The Table of Contents intelligently creates blocks of subcategories: for example, say you’re searching for all photographs taken in 2003—the TOC will break the year down into constituent months, allowing you to easily zoom into a particular month or time period. It also gives a visual indication of how your photographs align to the months. Thus if you snapped more pics in the month of March, 2003, the TOC would visually indicate a greater frequency of content in that month.

Apart from the organisational and retrieval features, Windows Photo Gallery also offers some rudimentary image manipulation tools (red eye removal, image cropping, exposure and colour controls) and even tools that will burn your photos to a data disc or a Video CD. It also allows you to make movies out of your photographs via integration with Windows Movie Maker.
4.5.11 Windows DVD Maker
This is a simple yet useful application that allows you to quickly make DVDs out of movies or photos to share with friends and family. You can simply drag and drop files into the application and Windows DVD Maker will intelligently create the necessary DVD menus. You can also control some aspects of DVD playback (whether the DVD should play the movies directly, or show the menu, for example) as well as control display aspect ratios (4:3/16:9) and the video format (PAL/NTSC).

4.5.12 Windows Media Center
Windows Media Center was earlier shipped as its own operating system—the Windows XP Media Center Edition. It is now also bundled along with Windows Vista Ultimate Edition. The program is primarily meant as a home entertainment hub, wherein the interface is either a large monitor or an LCD/plasma television. The interface is meant to be used from a distance of about 10 feet, and thus features large and colourful icons instead of a traditional menu layout. Windows Media Center is capable of organising and cataloguing several media pieces on your computer—from TV shows to movies to photographs; it can also record TV shows at specified time intervals and acts as a PVR if supported with the right hardware. To record TV, it requires a TV-Tuner card, either analogue or digital.
Recorded shows can either be burnt onto disc or transferred to a portable media player.

There are several geographical restrictions on this software—particularly—Windows Media Center can play HD video in all countries, but does not support HDTV in any country except the United States. Additionally, there is no support for HD-DVD or Blu-ray movies in any country. While HDTV sets are not supported, media managed through Media Center can be relayed to any standard TV set via Media Extenders or via the Xbox 360 game console. (A Media Extender such as the Xbox 360 game console allows you to stream your music, movies, and photographs to a television set.) Media cannot be transferred to another computer, however (for this you can always use Windows Media Player 11, assuming all computers have Vista installed).

### 4.5.13 Windows Meeting Space

As a replacement to NetMeeting, Meeting Space leverages peer-to-peer technologies in order to offer a single space to share applications and arrange for online meetings.

Meeting Space works similar to a peer-to-peer file sharing
program that is commonly used. The difference being that instead of sharing music and movies over a network, Meeting Space allows you to work collaboratively on files. Meeting Space can thus be used to share a presentation with your client—over a network, or to exchange files over the same P2P network. To start a meeting, two or more parties need to start a session first. A host typically starts such a session which can then be password-protected or left open to everyone over a network. Once this session is established, up to eight participants can share data using Meeting Space. Participants can also be invited through e-mail or via an invitation file. Handouts outlining the agenda of the meeting or other vital information can also be shared during a meeting which can take the form of several supported formats including text files. Meeting Space allows collaboration over several networks—local, wireless, or peer-to-peer. Apart from sharing the entire desktop with members in a meeting, Meeting Space also allows you to share specific applications or even selective files stored on your computer.

To start a new meeting using Meeting Space:
1. Start Meeting Space by typing ‘mee sp’ in the Search box under the Start menu OR by clicking on All Programs > Windows Meeting Space
2. If this is the first time you open Windows Meeting Space, you will be prompted to turn on some services and sign in to ‘People Near Me’
3. Click ‘Start a new meeting’, and then type a name and password for the meeting. The password must be at least eight characters long
4. If you want to change visibility or network options for the meeting, click Options
5. Click the green arrow pointing right to launch the meeting

To join a meeting using Meeting Space:
6. Start Meeting Space by typing ‘mee sp’ in the Search box under the Start menu OR by clicking on All Programs > Windows Meeting Space
7. If this is the first time you open Windows Meeting Space, you will be prompted to turn on some services and sign in to ‘People Near Me’
8. Click Join a meeting near me, select the meeting you want to join, type the password for the meeting, and then green arrow pointing right

People Near Me’ is a service that helps identify a peer-to-peer connections. It identifies people nearby who are using computers and allows those people to send you invitations for programs such as Windows Meeting Space.

4.6 Speech Recognition

The holy grail of a human-machine interface—at least if you are a fan of science fiction—is that of a mechanism through which a machine understands your commands and obeys! Fetch me my coffee, Vista—no milk, hold the sugar!

This dream of the lazy, and the overworked, and the solution for the differently-able is a step closer to reality today. Windows Vista ships with a comprehensive suite of programs that together offer an accurate speech recognition engine.

Bill Gates has long made it known that he personally sees two important facets of development in the computer space, with regard to the interface. One of the solutions he is passionate about is the concept of the Tablet PC, which is essentially a computer
that allows you to write naturally on its screen and converts your handwriting into editable, electronic “ink.” The other concept is of speech recognition. To that end, Microsoft has been researching and developing speech technologies for over a decade. In 1992, Carnegie Mellon University unveiled the Sphinx-II speech recognition program, which immediately earned rave reviews and accolades for its unprecedented accuracy. Microsoft then did what it does best—in 1993, the company hired Xuedong Huang, Fil Alleva, and Mei-Yuh Hwang—three of the four people responsible for Sphinx-II speech. Built on their work, in 1994, Microsoft released the Speech API (SAPI), which exposed some powerful speech features to interested developers.

Recently, the company has made some progress in bringing speech recognition to consumers. The first comprehensive solution to this end was Voice Command, which allowed users to control Windows Mobile applications and interface elements. With Windows Vista, Microsoft brings both a speech solution for developers (through an API) and for the consumers.

On the developer front, Windows Vista includes a new WinFX namespace (a namespace is essentially a container), System.Speech, which allows developers to easily speech-enable Windows Forms applications and apps based on the Windows Presentation Framework. SAPI has also been updated to 5.3 to give native code access to the enhanced speech capabilities of the platform.

For consumers, Vista has an inbuilt speech recognition interface. This is designed to allow control of Vista without a keyboard or mouse. Moreover, the speech features extend to all elements of the OS, and is not limited to Microsoft products. Vista also bundles along a general-purpose speech recognition engine, which is quite accurate in recognition and is also available in a variety of languages. Vista also includes the first of a new generation of speech synthesisers to come out of Microsoft, completely rewritten to take advantage of the latest techniques.
Behind speech technology are two aspects that determine the voice-to-text flow. You have the speech synthesisers, which take in text as input and produce an audio stream as the output. These are generally referred to as text-to-speech (TTS) programs. You also have a speech recogniser, which is a program that turns the input and output streams of the TTS around: recognisers take in audio streams and output text.

For a synthesiser to work, it needs to first analyse the string of characters that form the text, keeping a strong emphasis on grammar rules, natural language rules, and the language itself. English, for example, is a far easier language to deal with than, say, Japanese. The program thus needs to figure out multiple details on the text: which words are proper nouns, numbers, exclamation points; where sentences begin and end; whether a phrase is a question or a statement; and whether a statement is in the past, present, or future tense. These elements are all vital in determining the final output—the appropriate pronunciations and intonations for the words and phrases that form the sentence.

The system must then analyse and generate appropriate sounds for the processed text. It needs to determine where to add emphasis, where to break, or pause, mid-sentence, and so on. Finally, it has to actually speak out the sentence—this was done algorithmically in the past, which generated the typical “computer-sounding” voice that is common to such solutions. Windows Vista utilises a database of sound segments built from hours and hours of recorded speech. The program thus selects the appropriate sounds from this database and then splices these various sound segments together to speak the sentence.

Speech recognition is vastly more complicated than synthesis. You can imagine the scale of complication when you realise that the input is essentially a sound wave that needs to be analysed and processed—to understand everything from intent to placement within a statement. A speech recognition program needs to process the audio stream and isolate the segments that it recognises as actual speech
(eliminating background noise, this is why it is recommended that you use a good array microphone for speech dictation, which does most of the noise cancellation work for the software). The system then needs to convert these “possible speech” elements into a series of numeric values which define the sounds in audio signal. Under Vista, these numeric values are then used to launch a search across three databases: an acoustic model, a lexicon, and a language model.

The acoustic model represents the sounds of a language (under Vista, you can train this module to better recognize your speech patterns). The lexicon is, of course, a comprehensive list of the words that form the language; it also offers pronunciation guides on each word. Now that the system knows what you are saying, it uses the language model to determine the best manner in which the different words you spoke need to be combined.

Human speech, of course, does not possess a precisely definable property—the manner in which we speak can vary through a day, depending upon mood, or health, or any number of factors. It is therefore important to collect as much data on the user’s voice as possible. To this end, Windows Vista offers to spider through the user’s documents and emails to better understand the writing style of the user and to create a better user model. The quality of speech recognition also depends upon how well the backend of the system refines the database; and eliminates poor matches.

4.6.1 Accessing Speech Recognition under Windows Vista
Before you can use this feature under Vista, you need to quickly take the program through your voice-train it to better suit your pronunciation and intonations. The training can be accessed from the Start menu—All Programs > Accessories > Accessibility > Speech Recognition. Or you can do it the modern way by just typing in “speech” in the Search field of the Start Menu and selecting the program. The tutorial will first take you through setting up your microphone and then takes you through an interactive tutorial that explains how to use speech recognition technology and helps you train the system to understand your speech.
The system includes built-in commands for controlling Windows—allowing you to start, switch between, and close applications. You can use commands such as “Start Notepad”, and “Switch to Calculator.” You can also control screen elements through commands such as “Open”.

The dictation features allow you to convert voice to text, while edit controls are used to insert and correct dictated elements. You can also speak commands to select text, navigate inside a document, and make edits.

The system also offers text feedback keeping you in touch with what the system is doing, and providing necessary instructions. If the system is unsure of a word that you have spoken, it can also ask for clarification—offering you to choose the right instance from multiple possibilities. Finally, the system is learning and adapting to your voice and environment to improve accuracy over time.

4.7 Tablet interface

Windows Vista also offers handwriting recognition to those who either use a tablet with their computers, or use a Tablet PC. These tablet features are offered in the Ultimate and Business versions of Vista and come preloaded into any Tablet PC laptops. For those with a Wacom tablet, or similar solutions—these features add another layer of interaction with the computer. You can now write directly into ink-capable applications such as OneNote and Evernote, even Outlook and Microsoft Journal. Windows Vista indexes your handwritten notes allowing you to search and sort your handwritten data, just as easily as data traditionally typed through keyboard. Handwriting input is done through a Tablet Input Panel (TIP) which is now an integral part of Vista—TIP can also dock and hide to the edges, making it both accessible and out of sight. TIP can be used to enter handwritten text into any program or text box which takes text entry. The manner in which the program enters the information will depend on whether it is
“handwriting-aware”. Programs that support handwriting will take in the scribble directly, those that don’t will “translate” what you have written to traditional text. Handwriting recognition under Vista is more accurate than under previous versions; it also learns your writing as you use it more often. Learning is done transparently as you correct aspects of your scribble that the system recognizes incorrectly. Vista also adds a new element called ‘flicks’ to the navigation paradigm. Flicks are essentially gestures which ask the operating system to perform certain tasks. For example you can flick your pen up to ask a program to scroll up; flicking downwards will scroll down. You can also define your own flicks—this can be done through the Control Panel, under the Pen and Input Devices section.
No operating system can leave search behind, or worse, treat it as an afterthought. While Windows Vista no longer offers the extremely ambitious database-based WinFS file storage solution, the search features of Vista are pretty good.
We have a problem with data—there is too much of it. With increasing bandwidth leading up to the Internet, the amount of data one can come across can easily cross multiple gigabytes per day! Even e-mail solutions provide multiple gigabytes of storage space—it’s not just a marketing message anymore: storage space is cheap, data creation is cheaper, and the only thing that will take its toll on us would be making sense of it all. But before we can actually evaluate the multitude of data constantly streaming to our digital doorstep, we need to first find it. Not a small task in itself; in fact, it pretty much defines the old adage of looking for a needle in a haystack. How do you find that one song you feel like listening to in a library of three thousand? How much time will you need to spend looking for that one important e-mail from that person whose name you can’t recall—wasn’t it sent sometime last week? Search has taken the spotlight in this data-glut. The most famous and successful brands of recent times are all about search—imagine an entire multi-billion dollar industry just revolving around this simple concept of looking for what you need to find.

Not only does Vista offer a comprehensive tool to fashion your search query, it also ensures that you have multiple points of access to this very powerful tool. Let’s then take a close look at the search features offered by Vista, and the various elements that go into making Search work.

5.1 Starting With Search

Perhaps to underline the importance of search, you will find the first point of contact with the search tool right at the press of the Start orb; press the Windows key and Search is there, awaiting your command. As soon as you type the first letter of your search query, the Search engine immediately begins compiling a list of Programs; Favorites / Internet History; Files, including documents and media; and Communications, including e-mail, events, tasks,
and contacts that begin with that letter. It then intelligently displays these various elements in a categorised list—thus you will find all programs falling under one category, while documents will fall under another category heading. This first level of filtering by the Search tool itself helps in heading straight to the file you’re looking for. Interestingly, Search also offers you the option to take your query online: Search Computer and Search Internet are both preloaded with the letters you typed in the search box.

As you continue typing the letters, the engine filters the available results, categorising them as required. In addition to filtering and categorising, the search engine also considers the most likely candidate for your search query—this is displayed at the very bottom of the search results; if you press [Enter], Vista will load that file or open that folder.

That is the most basic face of the search tool. When you press [Enter] at the Start Menu’s search button, you are given another page that lists the actual search results in a two-pane window. This window can also be directly triggered by pressing the familiar Search shortcut: the [Window] + [F] keys. You can also launch this
5.1.1 Advanced Searching

This Search window provides additional tools to refine your search criteria. By clicking on the Advanced Search button, you can expose a plethora of search options that you can run next to your query. You can also ask the search engine to search around a variety of filters—for example, the obvious ones such as the name, date and location; but also the more esoteric options which will search on the basis of tags, keywords, comments, etc. Tags, incidentally, can be added under Vista for a variety of content. You can add a tag to images under the Explorer windows, or using the Windows Photo Gallery, and so on. Similarly, Vista exposes the ability to add tags around various pieces of content that you either create (such as a Word file) or gather (music and videos, as examples). Tags are also used by some Vista programs
to categorise and display your content—most notably by Windows Photo Gallery.

It would please the power users that Vista also offers Boolean operators to modify your search query: you can further narrow your search using the Boolean operators AND and OR.

Apart from these two windows of the Start menu and the search shortcut key, search is present practically everywhere in Vista. All Explorer windows, for example, offer a Search window in their upper-right corner. Many applications built around Vista also offer a search functionality (again, in the upper-right corner). Search is also seen in some dialog boxes, most notably in the File Open dialog (this is usually found in applications built around Vista; some older applications are not “search-aware”).

**Note**

Not all types of files can be tagged. Microsoft Office documents and JPG images can be tagged in Vista, but RTF (Rich Text), PNG, and .TXT files cannot be tagged.
5.2 Where Does It Come From?

While search is nothing new to the Windows world, what separates the Vista offering from the one of old is that this is, technically speaking, “search-as-you-type,” or a live search feature. You do not have to complete your query and press [Enter] to trigger the actual search (which might take a few minutes in older versions of Windows). Search starts on your data as soon as you start entering your query. So how is this done?

What Vista does is, it creates an index on all your content. An index file is essentially Vista drilling through your content and filing the various bits and bytes that define your content into multiple files. Thus Vista already knows which file contains what and where it is located—this is why the results are displayed instantaneously; Vista is essentially just filtering out all the data you do not need, based on your query.

Note, however, that Vista does not index everything by default. It focuses the indexing on specific locations such as your personal
folder under the OS—the place where you are most likely to save all your documents, e-mails, pictures, and so on. The indexing service itself runs as a service in the background and is constantly indexing all your content (the service runs at a very low priority and doesn’t impact performance). While indexing is done on specific folders by default, you can change its settings through the Control Panel by double-clicking the Indexing and Search Options icon. Moreover, as noted earlier, you can also add a location to an index every time you run a search query on that particular location.

**Tip** Vista’s search supports advanced operators such as author:, kind:, and tag:. You can thus fashion a query that will search for all the files written by “John” and tagged with “vista” and “inprogress”. Thus your query would be – author:Robert tag:vista tag:inprogress

### 5.3 Saved Searches

An interesting offshoot of the search feature under Vista is the concept of a virtual folder, or a saved search. A virtual folder is essentially a saved search: say you frequently look for information containing the keyword “John”. The search results on the query John can then be saved as a virtual folder. Such a VF will automatically refresh its contents with whichever new content piece is added to your system with the
connection point of “John”. Thus the VF might today show files containing that term, tomorrow it might reflect new e-mails sent by that person, and then later on that day, it might display photographs tagged with that word. The VF thus becomes a container collecting all the data points that have “John” in common. This is a very powerful feature, since it can act as a much more powerful organisational feature than your traditional directories and folders.

With the aid of virtual folders, you can create containers that collect information around multiple data points. For example, you can design one that lets you view all of your files by a particular author, one that lets you see only files that are attachments, or even one that shows you all files from a particular team project. For example, one can collect every document around keywords “John” “IT” for example—and it will automatically collect and update its content to include every mail from John in IT, and so on. This can also be extended to multimedia content wherein a virtual folder build around the query of “Rock” can collate all your music files tagged under the “Rock” genre. Since these folders are in essence, virtual, the space they occupy on your hard drive is minimal—which makes them an extremely powerful tool to categorise and sort your data.

Your saved searches are also displayed on all Explorer windows on the left-hand pane—they are thus easily available. Vista ships with a few default search folders, such as “Recently Changed”, which collate all the recently-modified files.

A saved search is also saved in your Searches directory. To open a saved Search, open Windows Explorer and click Searches. Double-click the saved search from the list and Vista will repeat the search.
Windows Vista takes security seriously. Very seriously—it has been touted as the most secure Windows OS yet. While that might not be saying much, the changes made to the system are indeed far-reaching and, well, secure.
Back when Bill Gates was Chief Software Architect under Microsoft, he called on employees to make security the primary focus of present and future Microsoft products. The announcement was made in the atmosphere of distrust towards the organisation’s products, as every day seemingly brought new exploits and malware to the Microsoft ecosystem. Windows XP SP2 was the first step to rectifying this problem. Microsoft also made a series of changes to its internal structure and to the manner in which the company developed software. A security-focused engineering process called Security Development Lifecycle (SDL) was established within Microsoft to move security into the very essence of software design; all widely deployed Microsoft products must follow these guidelines.

Windows Vista is the first large project to be launched under the aegis of SDL. It includes new or upgraded inbuilt security technologies that actively work to detect and prevent security threats. These changes include the new User Account Control feature, volume encryption using BitLocker, code integrity verification, Windows Defender, Windows Firewall, and a new Security panel. Let’s take a closer look at each of these elements and understand how they protect the OS, and what changes they bring.

6.1 User Account Control (UAC)

There are generally two types of users in any operating system—those who can make changes to the system’s files and settings, and those who cannot. For Windows XP, the OS would by default grant a user all the rights and privileges required to make changes to the operating system. While this made it easier for a user to install programs, move folders, remove programs, change time zones and so on, it also opened up a huge security hole for malicious programs. Any program that ran in such a high-privileged atmosphere inherited all the rights from the user and was thus just as capable of making system-wide and potentially harmful changes.
Windows XP was also capable of offering a lower level of account, but this removed from the users hands the capability to make everyday changes to the system such as changing the time zone, or install a new device (a camera, for example). The inability to make such changes was one of the major reason that both home users and office computers were often configured with full-access under Windows XP.

Vista offers a middle road which, while allowing a level of flexibility to what a user can or cannot do inside an OS, also keeps security primarily in mind. Under Vista, there are two types of user accounts: the Administrator account and the standard user account. “Standard user accounts” are equivalent to the similar standard user account in previous versions of Windows. They have limited administrative privileges and user rights—they cannot install or uninstall applications that install into system’s root directory, change system settings, or perform other administrative tasks. However, standard users can perform these tasks if they are able to provide valid administrative credentials when prompted. This is to be expected; what Vista does differently is how it treats the Administrator accounts. While in the previous versions of Windows, an administrator account was granted the right to do any change needed, Vista limits the account privileges at the onset. With UAC enabled, members of the local Administrators group run with the same access token as standard users. The system grants the Administrator full rights only when the user grants the approval. This fundamental change is the cornerstone of User Account Control under Vista. There are thus three possible scenarios:

1. You are logged in as administrator: by default you are actually running as a standard user and all applications running in the session are also running with low-privilege settings. Thus when an application needs to make system-level changes you will be prompted by the operating system to verify, confirm, and allow that program or task to make the changes. This verification takes the form of a prompt, generally referred to as the eleva-
tion prompt. When you confirm that action, the program in question is granted the admin-level rights and privileges to make the necessary changes.

2. You are logged in as standard user but know the admin password: the scenario here is similar to the one above. The difference here is that your actual account does not belong in the Local administrator’s group, and you are not allowed to make any changes to the system by default. When a program requires system access, you will be prompted to supply the administrator password—upon success, the program would be able to run as needed; else, if you do not have the required access rights, that is, you are not an administrator, you will not be able to make any changes at the system level. A standard user is not completely powerless to make changes to the system, however, which brings us to our next point:

3. You are a standard user without knowledge of the admin password. In this case you are granted some rights by Vista, mostly limited to making changes to your personal files, folders, and settings. You cannot make any system-wide changes and thus neither can any programs run by you.

To get a better idea of what differentiates a standard user from an Administrator under Vista, take a look at the table on the opposite page:

**6.1.1 Changes Introduced By UAC**

Since UAC implies that even an Administrator doesn’t have access to system resources by default, some older programs from Windows XP days might have problems running under Vista. To better understand why, let’s quickly take a look at exactly what happens when an admin logs into a Vista system.

Upon login, the system issues a token to the user, which determines just what the user can access—the token defines the privileges and the access rights of the user. Under XP, the system would issue just one such: you were either an admin or a standard user. Vista, though, issues two tokens to an administrator account. The
<table>
<thead>
<tr>
<th>Standard/Administrator</th>
<th>Standard Users</th>
<th>Administrator</th>
</tr>
</thead>
<tbody>
<tr>
<td>Establish a Local Area Network connection</td>
<td></td>
<td>Install and uninstall applications</td>
</tr>
<tr>
<td>Establish and configure a wireless connection</td>
<td></td>
<td>Install a driver for a device (E.G. a digital camera driver)</td>
</tr>
<tr>
<td>Modify Display Settings</td>
<td></td>
<td>Install Windows updates</td>
</tr>
<tr>
<td>Users cannot defragment the hard drive, but a service does this on their behalf</td>
<td></td>
<td>Configure Parental Controls</td>
</tr>
<tr>
<td>Play CD/DVD media (configurable with Group Policy)</td>
<td></td>
<td>Install an ActiveX control</td>
</tr>
<tr>
<td>Burn CD/DVD media (configurable with Group Policy)</td>
<td></td>
<td>Open the Windows Firewall Control Panel</td>
</tr>
<tr>
<td>Change the desktop background for the current user</td>
<td></td>
<td>Change a user’s account type</td>
</tr>
<tr>
<td>Open the Date and Time Control Panel and change the time zone</td>
<td></td>
<td>Modify UAC settings in the Security Policy Editor snap-in (secpol.msc)</td>
</tr>
<tr>
<td>Use Remote Desktop to connect to another computer</td>
<td></td>
<td>Configure Remote Desktop access</td>
</tr>
<tr>
<td>Change user’s own account password</td>
<td></td>
<td>Add or remove a user account</td>
</tr>
<tr>
<td>Configure battery power options</td>
<td></td>
<td>Copy or move files into the Program Files or Windows directory</td>
</tr>
<tr>
<td>Configure Accessibility options</td>
<td></td>
<td>Schedule Automated Tasks</td>
</tr>
<tr>
<td>Restore user’s backed-up files</td>
<td></td>
<td>Restore system backed-up files</td>
</tr>
<tr>
<td>Set up computer synchronisation with a mobile device (smartphone, laptop, or PDA)</td>
<td></td>
<td>Configure Automatic Updates</td>
</tr>
<tr>
<td>Connect and configure a Bluetooth device</td>
<td></td>
<td>Browse to another user’s directory</td>
</tr>
</tbody>
</table>
first token identifies the user as an admin, but is immediately filtered down to a standard user token. Under this standard user token, Vista launches the Explorer.exe process, or the shell inside which the user will work. Since Explorer is now running with standard privileges, and since any application launched from Explorer will inherit those standard privileges, all applications and tasks run by the administrator are now run as standard users. A user who is a member of the Administrators group can now log in, browse the Web, and read his mail while using a standard user access token. When the administrator needs to perform a task that requires the administrator access token, Windows Vista automatically prompts the user for approval.

Windows Vista protects processes by marking them with integrity levels. Integrity levels are measurements of trust. A “high” integrity application can modify system data, while a “low” integrity application might be a Web browser. Vista prevents applications with lower integrity levels from modifying data in applications with higher integrity levels.

Applications written specifically for Windows Vista will understand this nature of UAC fine; however, older applications running under Vista might fail to run, or might run in an unexpected manner. To allow for these older apps, Windows Vista offers virtualisation of key resources. The virtualisation essentially fools the older application into thinking that it has the required access to the necessary files/folder/Registry, but Vista is actually running those “simulated” resources in a safe and protected place.

Windows Vista includes file and Registry virtualisation technology for applications that are not UAC-compliant and that have historically required an administrator’s access token to run correctly. When such an application attempts to write to a protected directory, or to the Registry, Vista creates a virtual instance of the resource it is attempting to change. The virtualised copy is maintained under the user’s profile and is prevented from making actual changes to the system at large.
Programs and activities which require a UAC prompt are marked with a shield icon. If you are an Administrator, starting these programs would require an elevation; if you are a standard user without access to the administrator password, you will not be able to perform such tasks, or launch such applications.

6.1.2 Making Changes To The Way UAC Is Implemented
UAC is enabled by default under Vista: on new installations, the first user account created is a local administrator account with UAC enabled. All subsequent accounts are then created as standard users. If Vista was installed as an upgrade from Windows XP, and if Vista detects that the XP system only has an Administrator as the only active local administrator account, Windows Vista leaves the account enabled and places the account under UAC. The built-in Administrator account of Vista, by default, cannot log on to the computer in safe mode.

There are several ways one can work with the UAC feature of Vista. You might want to “elevate” and run an application once, or you might want to give a certain application admin privileges every time it runs and thus always run it elevated; finally, you might want to disable UAC altogether. Typical scenarios are thus:

Scenario 1: Request an application to run elevated one time
This is the scenario that will be the mostly common. Here, say you need to run a program which requires a system-access—this could be as simple as wanting to move a folder from one place to another, or having to uninstall a program.

1. When you start the application or a task which require elevation, a User Account Control prompt is displayed
2. Verify that you know the program to be trustworthy, i.e. confirm that the details presented match the request you initiated
3. In the User Account Control dialog box, click Continue to start the application

The application or the task will now run elevated, with the required permissions.
Scenario 2: Mark an application to always run elevated

You may sometimes be required to grant permission to an application to always run elevated. This could be required for a program that you regularly use which demands system-level access: say for example a BitTorrent client that needs to access folders and drives frequently. In such a scenario, it may be necessary to grant a permanent elevation to the program.

1. Find the executable for the application that you wish to elevate and then right-click the particular application.
2. Click on Properties, and then select the Compatibility tab.
3. Under the Privilege Level, select “Run this program as an administrator”, and then click OK.
If this option is unavailable, it could mean one of several things: the application is blocked from always running elevated; the application does not require administrative credentials to run; the application is part of the current version of Windows Vista, and you are not logged into the computer as an administrator.

Scenario 3: Disabling UAC

UAC is a granular system and there are levels to the feature which determine how the system behaves. You might want to disable the feature altogether or instead, tweak the manner in which UAC behaves. To perform any of the following procedures, you must be logged on as a local administrator.

To turn off UAC altogether:
1. Open the Control Panel by clicking on Start > Control Panel
2. In the Control Panel’s search box, type “UAC” and press Enter. This will display a search result with the option to turn UAC off. Alternatively, you can click on “User Accounts and Family Safety” inside Control Panel and then on “User Accounts” and finally on “Turn User Account Control on or off”
3. Vista will prompt you for a confirmation
4. You will need to restart the system to accept the changes

To turn UAC back on, follow these steps:
1. Open the Security Center by typing out ‘Se Ce’ in the Start menu’s search box. You can also find Security Center in the Control Panel.
2. Inside Security Center, the “Other
security settings” option will display that the “User Account Control” option is turned off
3. Click on the “Turn on now” button to turn on UAC
4. Vista will prompt you to restart the system to accept the changes

You can also disable Admin Approval Mode to turn off UAC:
1. Type “secpol.msc” in the Search field under the Start Menu and press [Enter]
2. If UAC is active, a User Account Control dialog box will appear; click Continue

3. From the Local Security Settings console tree, click Local Policies, and then click Security Options
4. Scroll down and double-click “User Account Control: Run all administrators in Admin Approval Mode”
5. Here, click Disabled, and then click OK
6. Close the Local Security Settings window and restart your system

In regards to disabling UAC from prompting for credentials to install applications, disabling UAC altogether is not recommended and might not even be necessary. You can change the way UAC
tackles application installs—specifically, you can disable UAC prompts every time you install an application as a local administrator:

1. Type “secpol.msc” in the Search field under the Start Menu and press [Enter]

2. From the Local Security Settings console tree, click Local Policies, and then Security Options

3. Scroll down and double-click “User Account Control: Detect application installations and prompt for elevation”

4. Here, click Disabled, and then click OK

5. Close the Local Security Settings window and restart your system

Change the UAC elevation prompt behaviour:

1. Type “secpol.msc” in the Search field under the Start Menu and press Enter

2. From the Local Security Settings console tree, click Local Policies, and then Security Options

3. Scroll down to and double-click “User Account Control: Behavior” of the elevation prompt for administrators or “User Account Control: Behavior” of the elevation prompt for standard users

4. From the drop-down menu, select one of the following settings:
   - No prompt
   - Prompt for credentials (this setting requires username and password input before an application or task will run as elevated,
and is the default for standard users)

- Prompt for consent (this is the default setting for administrators only)

5. Click OK
6. Close the Local Security Settings window

For more on how exactly to use and make modifications to user accounts, refer Chapter 7.

### 6.2 BitLocker

With the advent of laptops and Flash drivers, your data is now mobile. While your workplace might have security policies in place, the operating system can only enforce the policies on a local computer system, and then again, only when it is active. Data protection when a system can be attacked from the outside is also important. Hardware-based mechanisms such as BIOS passwords and encryption are two technologies commonly used to prevent unauthorised access, especially on laptops, which are more likely to be lost or stolen.

One such encryption technology used by Windows Vista is Encrypting File System (EFS), which was initially introduced under Windows 2000. EFS under Vista introduces a number of improvements to performance and extends support for encryption of the paging file. EFS keys can also be stored on smart cards, under
Vista. EFS, however, is not a volume protector; it works on a file level. You cannot therefore use EFS to effectively protect sensitive areas of the system such as the Registry hive files.

In order to introduce encryption to the entire boot volume (including all files, Registry and otherwise, and data), Vista introduces Windows BitLocker Drive Encryption. Where EFS was implemented by the NTFS file system (as we mentioned, it worked on a file level), BitLocker encrypts at a volume level using a new driver called the Full Volume Encryption (FVE) driver. FVE sits between the NTFS file system and the data in the file system layer that it interacts with. It essentially acts as a filter, in that it transparently passes file requests from the NTFS layer to the layer below, and does its job on the fly: FVE sees all the I/O requests that NTFS sends to the volume, encrypting blocks as they’re written and decrypting them as they’re read. NTFS need not be even aware of the BitLocker protection since the encryption and decryption happen beneath NTFS and the encrypted the volume appears unencrypted to NTFS. If you attempt to read data from the volume from outside of Windows, however, it appears to be random data.

By default, volumes are encrypted using a 128-bit AES key called the Full Volume Encryption Key (FVEK). The FVEK in turn, is encrypted with a Volume Master Key (VMK). The VMK specifically can be protected in a number of ways, depending upon your system’s hardware. A system with TPM (Trusted Platform Module) v1.2 support at the BIOS level can either encrypt the VMK with the TPM, have the system encrypt the VMK using a key stored in the TPM and one stored on a USB Flash device, or encrypt the key using a TPM-stored key and a PIN you enter when the system boots. For systems without TPM, you can encrypt the VMK using a key stored on an external USB Flash device.

Under BitLocker, the system goes through a verification chain, where each component in the boot sequence describes the next component to the TPM. Only if the entire chain of authorisation succeeds will the TPM allow access to the system. BitLocker there-
fore protects the encrypted data even when the disk is removed and placed in another system, the system is booted using a different operating system, or the unencrypted files on the boot volume are compromised.

6.3 Code Integrity Verification

Malicious programs (malware) are a common occurrence in the Windows world. There are several established tools which work to identify and root out malware external to the system—such as viruses, worms, Trojans and such. However, there is another form of malware that seeks to undermine and attack a system from within. Such software is generally implemented to run at a kernel level and runs with the same privileges that the kernel enjoys. These are therefore most difficult to identify, isolate and remove.

Vista introduces functionality that aims to separate malware from real applications and device drivers. Through a code integrity initiative, Vista uses certificates to identify and allow digitally signed device drivers to run. This feature—the kernel-mode code signing (KMCS)—only allows device drivers to load if they are published and digitally signed by developers who have been examined by one of a handful of certificate authorities (CAs).

KMCS uses public-key cryptography to implement authoritative certificates for programs and drivers. A software publisher can either get the appropriate certificate from Microsoft itself (though the Windows Hardware Quality Laboratory, WHQL), or they can obtain a certificate from one of the authorities that Microsoft has identified as trusted. The authority then digitally hashes the code, signs the hash by encrypting it with a private key, and includes the certificate and encrypted hash with the code.

When a driver tries to load, Windows decrypts the hash included with the code using the public key stored in the certificate, then ver-
ifies that the hash matches the one included with the code. The authenticity of the certificate is checked in the same way, but using the certificate authority’s public key, which is included with Windows.

KMCS is enforced by default on Windows Vista for 64-bit systems, and this version of Vista blocks an unsigned application and silently logs the event. The 32-bit version of Vista however, allows unsigned drivers to load as blocking them would break upgraded Windows XP systems. This is also required since certain drivers might only have XP versions which might not come with certificates. However, 32-bit Windows Vista also writes events to the Code Integrity event log when it loads an unsigned driver.

6.4 Windows Defender

To protect your system from malware in the form of spyware, Trojans, rootkits and Web browser exploits, Vista introduced the Windows Defender under Windows XP SP2. While Defender is available as a download for XP, it comes as an inherent part of Windows Vista. Defender is a real-time and a background service which starts with Windows and runs continuously in the background. The service constantly scans your files and network activities and alerts you when it stumbles across a suspicious file, or intercepts a malicious program from running or installing on your system. By default, Defender will also update itself every night at around 2 AM in order to be rele-
vant as a system protector. Also by default, Defender will automatically remove all high-threat risks. These settings can be changed through the Tools > General Settings option in Windows Defender.

Defender alerts you visually whenever it detects malicious software. When a low threat is detected, Defender lets you know by displaying an exclamation point in the system tray. For medium or high threats, which require an immediate response, Windows Defender displays a yellow or red dialog depending upon the threat level.

While Defender is always running and scanning your system for malware, you can initiate a system scan yourself, whenever you feel it necessary. Windows Defender offers three types of scans:

- A Quick Scan will check places on your system which are most likely to be infected
- A Full Scan will scan all running applications, the registry and all the files on your hard disk
- Through a Custom Scan you can specific files or folders to check
You can start one of these scans by clicking on the arrow next to the Scan button. When a threat is detected in such a scan, there are several options available to you:

- Remove the threat from your system completely
- Ignore the threat. Windows Defender will detect the threat in a future scan
- Quarantine the threat. If you are unsure of the effect removing the threat might have on your system, you can temporarily quarantine the threat. Quarantined items can then be removed or restored, accordingly
- “Always allow” will stop detecting the threat and add it to the allowed items list. You can remove items from the allowed items list by clicking Tools > Options in Windows Defender
6.5 Windows Firewall

Windows Firewall builds on the firewall introduced under XP to offer a bidirectional firewall which tracks and filters both inbound and outgoing traffic under Vista.

By default, the Vista firewall blocks all incoming traffic unless it is solicited or matches a rule, and allows all outgoing traffic unless it matches a rule. These rules can be set or modified through the Exceptions List: go to Start > Control Panel > Security, and then “Allow a program through Windows Firewall”. You can also set rules for the firewall, in order to configure it for various services and protocols:

- Active Directory accounts and groups
- IP protocol number
Specific types of interfaces
Services
ICMP and ICMPv6 by type and code
Source and destination IP addresses
All TCP or UDP ports, or specified ports

Windows Vista creates a firewall profile for each network that you connect to. Future connections to that network then invoke the saved profile. Thus when you connect to a new net-

Windows Firewall Connections

work, Vista will ask you to identify the same and categorise it as either Public (asking for greater protection), or as Private (which calls for slightly relaxed rules). Windows Firewall will then modify rules accordingly. To change this profile, go to Start > Control Panel > Network and Internet > Network and Sharing Center, and then click on Customize next to the name of the network to which you are connected.
6.6 The Security Panel

Windows Vista’s Security Panel offers a unified place to access and modify all the operating system’s security settings. It is also the place to go if you want to check up on the security status of your OS. While such a central console was first presented under Windows XP SP2, Vista’s iteration is even more comprehensive and useful.

The panel can be found inside the Control Panel which in turn can be started from Start > Control Panel. Click on Security to open the Security panel. Before you do that, note how the Control Panel offers direct links to the most used tasks right under the “Security” heading:

- Check for updates
- Check this computer’s security status
- Allow a program through Windows Firewall

Note the shield icon before “Allow a program...”; this indicates that the task requires a UAC elevation to execute. Let’s take a look at the various options available here—from top to bottom we have:
6.6.1 Security Center
The Security Center is the one-stop to check up on all the security settings on the OS. It displays the status of the most important security elements which are required to protect Vista. Clicking on the Security Center you will find information on:
- The Firewall status
- Status of Windows Updates—specifically if Automatic updating is on
- Malware protection—here you can find out if you have an antivirus software installed, and if so, are the virus definition files up to date; you can also find out the status on Windows Defender or any third-party anti-spyware product
- The “Other security settings” keeps a track of the Internet security settings and whether the UAC feature is turned on

While the right-hand side of the Security Center display status information, the left-hand pane will give you one-point access to each of the programs that the Center is tracking. You can thus access:
- Windows Update
- Windows Firewall
- Windows Defender
- Internet Options

from the left-hand pane; this helps you make immediate changes to these security systems if the Security Center finds something amiss.

6.6.2 Windows Firewall
This option will give you access to the settings of the Windows Firewall. You can turn the Firewall on or off right here, you can also allow a program through the firewall. When you click on the “Windows Firewall” option, you will be presented with the Firewall status. To change any settings, click on the “Change settings” text link. This will open the Windows Firewall Settings window: the first tab, General, allows you to turn on or off the Firewall itself. The second tab, Exceptions, will allow you to add a program to the Exceptions list, thus allowing it to access the Internet. You can also
open a port to the firewall: to add a program to the Exceptions list, click on the “Add program” button and to add a port to this list, click on “Add port” (the port can either be TCP or UDP).

Finally, you have the Advanced tab, which allows you to turn the firewall on or off for each of the network connections you might have on your computer.

**6.6.3 Windows Update**

Once again, the most frequent tasks that you might want to carry around Updates are immediately listed right below the “Windows Update” option. You can thus turn automatic updating on or off, or manually check for updates, or even view all the updates that have been installed on your computer till date. Clicking on Windows Update will take you to a screen that offers status information. This information is generally on
OS updates, but might include any application update that the service discovers (note that you must enable the “Update service” to receive updates for Microsoft and other products for such information to be visible). If you are using Windows Vista Ultimate Edition, you are entitled to some bonus software that Microsoft releases from time to time; these might appear on this page, if available.

The left-hand pane here is as important as the right-hand information display. Here, you can:

- Check for updates—manually check for Windows Updates
- Change settings—change whether updating is automatic and if so, when it should be triggered. You can also determine whether the Update feature will include recommended updates in the automated process, and also if you need to widen your search to other products
- View update history—Vista keeps record of all the updates that you have installed; you can see the log here
- Restore hidden updates—you can “hide” some updates that are not needed for your computer, such as language packs for foreign languages. A hidden update will no longer appear on the list of updates available for Vista; it’s a good feature that helps keep the update list manageable and short. You can restore this hidden list here, if you wish

6.6.4 Windows Defender

This option will launch Windows Defender. We have already taken a close look at what this program offers. Note that status information on Defender can be found under the Security Center. Through here, you can launch the program and change its settings.
6.6.5 Parental Controls

You can use Parental Controls to set controls over your children’s interaction with the computer and manage these. For example, you can set limits on your children’s access to the Web, the hours when they can log on to the computer, and which games they can play and programs they can run.

Parental Controls can only be applied to standard user accounts. Therefore, each child you wish to set up this feature for needs to have a standard account associated with him or her. Note that you will need an Administrator account in order to set up these controls. Moreover, these cannot be set up for an admin account.

When Parental Controls blocks access to a Web page or game, a notification is displayed that the page or program has been blocked. Your child can click a link in the notification to request...
permission for access to that page or program. You can allow access by entering your account information. This is why it is important that your administrator account be configured with a password. As long as an administrator account has no password, any user can bypass or turn off Parental Controls.

To turn on Parental Controls for a standard user account:
1. Click to open Parental Controls. If you are prompted for an administrator password or confirmation, type the password or provide confirmation.
2. Click the standard user account for which you want to set Parental Controls.
3. Under Parental Controls, click On.

Once you’ve turned on Parental Controls for your child’s standard user account, you can adjust the individual settings that you want to control. You can control the following areas:

1. **Web restrictions**: These allow you to restrict Web sites; you can also block or allow specific Web sites. You can set up sites that children can visit, or make sure children only visit age-appropriate sites. You can also determine whether you want to allow file downloads, and set up which content you want the content filters to block and allow.
2. **Time limits**: You can set time limits to control when children are allowed to log on to the computer. Time limits prevent children from logging on during the specified hours and, if they are already logged on, they will be automatically logged off. You can set different logon hours for every day of the week.

3. **Games**: You can control access to games, choose an age rating level, choose the types of content you want to block, and decide whether you want to allow or block unrated or specific games.

4. **Allow or block specific programs**: You can prevent children from running programs that you don’t want them to run.

### 6.6.6 BitLocker Drive Encryption

This option grants access to the BitLocker program which we discussed at length earlier. From here you can either enable BitLocker or manage keys associated with BitLocker.
6.6.7 Secure Online Key Backup
This is an online service provided by Microsoft which allows you to store either the BitLocker recovery password, or the Encrypting File System recovery certificate on a free Microsoft web site called digital locker. You can then retrieve your password or certificate from this Web site from any computer that is connected to the Internet.
The biggest change that Windows Vista brings to the table is that of User Account Control—UAC has the single greatest impact on how one interacts with a Vista system. It also changes the manner in which users accounts are created under Vista. This chapter will take a brief tour of the ways in which one can manage accounts and maintain and modify privileges.
7.1 User Accounts

A user account is a collection of information on yourself—the user. This container of information tells Windows what files and folders you can access, what changes you can make to the computer, and your personal preferences, such as your Desktop background or the colour theme that you use. With the help of multiple user accounts, you can share your computer with friends and family and indeed colleagues, and still have your very own files and settings. Each person can thus access the same computer but can retain a level of personalisation on how they interact with the computer and also on the data that they store on the computer. Each person accesses their user account with a user name and password.

There are three different types of accounts:
- Standard
- Administrator
- Guest

Each account type gives the user a different level of control over the computer. The standard account is the account to use for everyday computing. The administrator account provides the most control over the computer, and should only be used when necessary. The guest account is primarily for people who need temporary access to the computer. To switch between accounts you can either log off from one account and then log into another, or you can switch users—which allows you to switch accounts without logging off (a logoff demands that all your programs be closed first). To Switch User, click on Start, then click on the arrow next to the lock icon, then on Switch User. Note that you can also log off from here.

As was seen in the previous chapter, there have been some elementary changes made to the way in which Vista handles and differentiates between accounts. One of the biggest changes is that the Administrator account is switched off under Vista, by default. If you have migrated to Vista from Windows XP and if Vista determines that the Administrator account was the only account avail-
able under XP, then the OS will migrate your settings and set your account as an admin but under UAC. Similarly, for a fresh install of Vista, the first account created falls under the administrator group but is depreciated using UAC. Thus, in effect, there are no administrators under Vista but only standard user accounts which might or might not be elevated to admin status through UAC. Apart from the one admin account created under UAC, Vista creates all future user accounts as standard users. We have already explored the limitations that a standard user faces as opposed to an admin, so let’s instead look at how you can add more users, and modify user settings under Vista.

Like all management features, you can access details on accounts through the Control Panel. Go to Start > Control Panel > User Accounts and Family Safety > User Accounts. Alternatively, you can also type out ‘us acc’ in the search field of the Start menu to filter out User Accounts.

Once you open User Accounts, you will find its layout similar to every Control Panel element: status and management features are available for modification on the right-hand side, and “Tasks” that you can perform on various aspects of User Accounts are presented to the left-hand side under the Tasks heading.

Let’s first take a look at the various changes that you can make to your User Account:

1. **Create a password for your account**: Many features rely on a password-protected user account; this is especially true for the admin account. For example, all Parental Controls require that you ideally set a password to your own admin account. Failure to
do so will create an easy way to bypass any controls you might have placed; even turning off Parental Controls can be easily achieved. While setting up a password, note that a good password must be at least eight characters long, and must ideally contain a combination of alphabets, symbols, and numbers. You can also set up a hint while creating a password, to remember it better — remember that anyone using the computer will be able to see the password hint. Note that this feature does not require a UAC prompt. Changing your own account’s password is one of the features which UAC now enables even non-administrators to perform.

2. **Change your picture:** You can first choose your display picture while setting up Vista on your computer. If you wish to change the picture in the future, the User Accounts is the place to do so. Clicking on the link will open a library of pictures that Vista offers for your user account. You can also choose a picture of your own and outside this library by clicking on the “Browse for more pictures...” link. Note that this picture will be seen on the Start menu and will also be used as the default picture for your Windows Contact. So choose accordingly. This feature, too, can be performed by a non-admin account.
3. **Change your account name:** This is an administrative action that will require an elevation prompt, and can thus only be done under an admin login, or by a standard user who knows the admin password. This option allows you to change the name of the user. This name will appear in the Start menu and the Welcome screen, and new personal directories under the new name would be created. Settings from your current directories will be migrated to the new one.

4. **Change your account type:** Another administrative action which requires an elevation. Here you can change the type of your account between an Administrator account and a Standard account. Note...
that Vista requires at least one admin account to function, and will thus ask you to create another administrator account if you wish to change the current admin account to a standard user account.

5. **Manage another account**: A typical admin task which will allow you to make the changes listed here to another standard user account.

6. **Turn User Account Control on or off**: You can turn off UAC from here.

Now that we have seen how we can manage an account, let’s move our attention to the left-hand pane and to the Tasks header. Here you will find a list of things that you can do with a user account, or to a user account. Let’s take this from the top:

1. **Create a password reset disk**: If you forget your computer password, you can use a password reset disk to create a new one. You should ideally create such a disk when you create a password for your account. You will need access to removable media such as a USB flash drive, a CD drive, or even your MP3 player.

   - Open User Accounts

   - In the left pane, click “Create a password reset disk”, and then follow the instructions. Make sure you store the password reset disk in a safe place
2. **Manage your network passwords:** Windows can store your login information and credentials for various services in a sort of a virtual keychain. When you ask Windows to store such a password (say, for example, the password to log into your instant messenger client), this is where it ends up. Similarly, passwords stored for Web sites, network resources, and programs are stored here. When you click on this link, Vista opens the program that manages your stored passwords—the “Stored User Names and Passwords” window. Here you can add, remove, and edit username and password combinations. You can also back up this virtual keychain to a disk; Vista recommends that you do so on an external disk which you can keep with you.

3. **Manage your file encryption certificates:** As we saw in Chapter 6, Vista offers the Encrypted File System (EFS) to encrypt your files at the NTFS level. To decipher these files, you need to have the encryption certificate and its associated decryption key on your computer, or on a smart card. You cannot access data encrypted via EFS without these two elements. This option allows you to engage with EFS in order to set up the necessary certificates and decryption keys. It also triggers a Wizard which will guide you through backing up the keys and certificates, and to set up EFS to use a smart card.

4. **Configure advance user profile properties:** A user profile is a container that stores settings for your Desktop and your account. You can either create a different profile for each...
machine that you use, or you can set up your profile as a roaming profile and use it across different computers. You can change your profile type here

5. **Change my environmental variables:** When you create an account, Vista sets up the system for you under the umbrella of several variable properties. For example, it needs to create a temporary folder just for your user account, one that can be used by both the OS for maintenance tasks and by various programs to store temporary data into. Similarly, it also stores path information on your profile: a path is essentially a list of directories that a program will access to find and run a command. These variables for your user account can be managed here
7.2 User Groups

A user group or a security group is a collection of user accounts that have the same security rights. The two most common user groups are the standard user and the administrator. If you have an administrator account, you can create custom user groups and determine which rights to assign to that group. An administrator can also move accounts from one group to another, add accounts to a group, or remove them from a group. A user account can be a member of more than one user group.

To create a user group:
1. Start Computer Management: type in “com man” in the search field of the Start Menu, then press [Enter]

2. In the left pane, click “Local Users and Groups”

3. Click Groups, and then click on “Action and New Group”

4. Type a group name and a description

5. You now need to add members to this group. Click Add, and then type the name of the user accounts
6. Click Check Names, and then click OK

7. Click Create

These steps cannot be completed on Windows Vista Starter, Windows Vista Home Basic, and Windows Vista Home Premium.

7.3 Creating A Strong Password

A good password will save you many a headache. While it might seem that every electronic transaction requires a password, taking this element lightly can cost you dearly. A password is generally considered the first line of defence against unauthorised access to your computer. While you might create a good password, make doubly sure that you do not give away this secret information to anybody else: social engineering is the most prevalent form of hacking out there—keep your password your own. Having said that, consider these tips, straight from Microsoft for creating strong passwords:

What makes a password strong (or weak)?

A strong password:

- Is at least eight characters long.

- Does not contain your user name, real name, or company name.

- Does not contain a complete word.

- Is significantly different from previous passwords.

- Contains characters from each of the following four categories:
A password might meet all the criteria above and still be a weak password. For example, Hello2U! meets all the criteria for a strong password listed above, but is still weak because it contains a complete word. H3ll0 2 U! is a stronger alternative because it replaces some of the letters in the complete word with numbers and also includes spaces.

Help yourself remember your strong password by following these tips:

- Create an acronym from an easy-to-remember piece of information. For example, pick a phrase that is meaningful to you, such as “My son’s birthday is 12 December, 2004.” Using that phrase as your guide, you might use Msbi12/Dec,4 for your password.

- Substitute numbers, symbols, and misspellings for letters or words in an easy-to-remember phrase. For example, “My son’s birthday is 12 December, 2004” could become Mi$un’s Brthd8iz 12124 (it’s OK to use spaces in your password).

- Relate your password to a favourite hobby or sport. For example, “I love to play badminton” could become ILuv2PlayB@dm1nt()n.

If you feel you must write down your password in order to remember it, make sure you don’t label it as your password, and keep it in a safe place.

---

**Acceptable Password Characters**

<table>
<thead>
<tr>
<th>Character category</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Uppercase letters</td>
<td>A, B, C</td>
</tr>
<tr>
<td>Lowercase letters</td>
<td>a, b, c</td>
</tr>
<tr>
<td>Numbers</td>
<td>0, 1, 2, 3, 4, 5, 6, 7, 8, 9</td>
</tr>
<tr>
<td>Symbols found on the keyboard (all keyboard characters not defined as letters or numerals) and spaces</td>
<td>` ~ ! @ # $ % ^ &amp; * ( ) _ - + = { } [ ] \</td>
</tr>
</tbody>
</table>
Windows Vista offers several new programs and features which help you make the most of the networked world. To better manage these connection points to an internal network or to the Internet, Vista also offers a unified control panel for network connections. This chapter covers Vista’s communication features in some detail.
Finally, Vista has updated old programs such as Internet Explorer to bring them on par with modern Web browsers, while it also introduces new software such as Windows Meeting Space, which leverage peer-to-peer and ad-hoc networking to communicate and interface with friends and colleagues. Let’s take a look at each of these features—from those that help us connect to a network, to those that help us troubleshoot a network connection.

8.1 A Central Networking Interface

Much like the central Security panel that Vista offers, the operating system also presents a central location from which to manage your various network resources. This management is done through the Network and Sharing Center, and can be accessed by going to Start > Control Panel > Network and Internet > Network Sharing Center.

The Network Sharing Center offers two aspects to your network: a status view on all your network connections is displayed to the right-hand side of the Center; the left-hand pane, meanwhile, offers links to common networking tasks.

The first item of notice is that the Network and Sharing Center displays a rudimentary map of how your computer is connected to
the Internet. This map includes both wired and wireless connections that your computer might be routing through in order to get to the World Wide Web. You can access a full view of this map by clicking on the “View full map” text link.

Next up, the Center displays individual connections under Vista. These generally include any onboard network ports, or LAN cards, or even wireless access points and routers. Each such connection is tagged with common tasks that you can perform around that network resource. As mentioned in Chapter 6: Security, under the Firewall section, each time you connect to a new network, Vista asks you to identify the network with a name and either a Private or a Public tag. Based on this, Vista creates firewall settings for each network. You can change these settings by clicking on the Customize text link to the right of each individual connection.

A Private network is appropriate for a home or a small office network, when you know and trust the people and devices on the network. For a Private network, Network discovery, which allows you to see other computers and devices on a network and allows other network users to see your computer, is On by default. A Public network is generally one that you access from a public place—such as a coffee house or a cyber-café, or an airport terminal.

For a Public network, Vista turns off Network discovery. The Public tag is designed to keep your computer from being visible to other computers around you and to help protect your computer from malicious software from the Internet.
The Public location blocks certain programs and services from running, to help protect your computer. If you are connected to a Public place and Windows Firewall is turned on, some programs or services might ask you to unblock them in order to work properly. When you unblock a program, Windows Firewall unblocks it for every network tagged with the same location-type. For example, if you identify an airport terminal as Public and then enable an instant messenger to run on that Public network, Vista will enable IM access to all Public networks.

8.1.1 To Change A Network Location Type
If your computer is part of a domain, you won’t be able to change the network location type because it is controlled by your network administrator.
1. Log on to the network
2. Go to Start > Control Panel > Network and Internet > Network Sharing Center
3. Click “Customize” next to the network you wish to change, and then click either Public (for “Public place” networks) or Private (for “Home” or “Work” networks)
4. Click Next, and then click Close

Just after all the network locations are listed, the Networking and Sharing Center will display the “Sharing and Discovery” settings of your computer. Note that these settings are dependant upon your firewall settings and, more specifically, on how you have identified your network to Windows—either Private or Public. The various options available here are:
1. **Network discovery**: When Network Discovery is turned on, your computer can see network resources (printers and PCs alike), and is similarly visible to other computers. From here, you can turn this setting on or off (requires a UAC prompt). You can also change your Workgroup settings from this place.

2. **File sharing**: You can turn on or off file sharing from here. You can share files from any folder on your computer or from the Public folder.

3. **Public folder sharing**: With this option on, people on your network can access your Public folder. Every user under Vista gets a Public folder of their own. This folder can be used to easily share information and files with others on your network: any file or folder you put in the Public folder is automatically shared with the people who have access to your Public folder. Depending upon the version of Vista that you have, the Public folders can be: Recorded TV, Public Documents, Public Videos, Public Music, Public Downloads, and Public Pictures. These locales can be accessed by typing Public into the search field in the Start menu.

4. **Printer sharing**: This option allows you to share an installed printer with others on your network.

5. **Password protected sharing**: When this is turned on, only people who have a user account and password on your computer can share files and resources attached to it. To give other people access to this information, you have to turn off Password Protected Sharing.

6. **Media sharing**: Media sharing allows people on the network to access shared music and videos. This type of share also enables your Windows Media Player to share playlists and library content with other people on the network. You need to enable this share if you wish to use an Xbox 360 console to stream music and videos to a television set. Note that other people must also be on Windows Vista for this to work between computers.

Finally, Vista also offers two quick links to see which resources you are currently sharing with the rest of the network: “Show me all the files and folders I am sharing” will trigger a system Search which will display all your shared content. “Show me all the
shared network folders on this computer” will show you shared drives and partitions on your system.

With a look at how to access and manage all your network resources, let’s move on to some common network setup tasks. As mentioned earlier, quick links to such tasks can be found right in the Network and Sharing Center to the right-hand side, under the appropriately-named ‘Tasks’ heading. These Tasks are:

1. **View computers and devices:** This setting will display all the devices (printers, gateways, etc.) and personal computers that share your network. When you click on this link, Vista will refresh its list of networked devices (a bright green bar will fill the address bar to show that this refresh is taking place). Through here, you can also add resources to your network.
   a. To add a printer, click on the “Add a printer” button on the context task bar. Note that you can add either a local printer connected to an LPT or a USB port, or a Bluetooth printer connecting wirelessly to your computer. Follow the Wizard to complete the addition.
   b. To add a router or an access point, click on the “Add a wireless device” button. Vista will then launch a search for all available wireless devices in the vicinity of your computer. Follow the Wizard to add them.

2. **Connect to a network:** If you find yourself skipping networks throughout the day, this option will come in handy. Through here you can change which network connection Vista should currently use to get to the Internet. The connections can be
either dial-up, or VPN, or wireless. You can thus create profiles for each of your connection points and then switch between them from here. For example, say you use a dial-up network from home, a VPN from office, and you frequently find yourself in a coffee shop that uses a wireless connection. You can use this feature to switch between the three.

3. Set up a connection or network: While the above setting allows you to switch between different networks, this particular feature will allow you to create the connection points needed above. When you click here, Vista will present you with various options which you can use to connect to a network—whether for a workplace connection or for connecting to the Internet. Clicking on this entry will open up a Wizard which will offer these options:
   a. Connect to the Internet, which will take you through the steps needed to set up a
wireless, broadband, or dial-up connection to the Net
b. Set up a wireless router or access point, which will take you through the steps needed to create a small wireless network at your home or workplace
c. Set up a dial-up connection, which will take you through the steps needed to connect using a modem
d. Connect to a workplace, which will let you connect to a VPN

4. Manage network connections: This setting will open up all the active connections on your network and allow you to manage them. For example, you can use this setting to enable or disable an onboard network controller, or to share a connection with another network user.

5. Diagnose and repair: If you are experiencing trouble with one or more network resources, click on this link to ask Vista to try and solve the issue. Vista will try to automatically solve common issues with networks by restarting devices, or refreshing their IP addresses, and so on. If all fails, Vista can also suggest some repair options (disable and re-enable a device, or reboot an access point, etc.). Vista will also offer to report the problem to Microsoft if it is unable to resolve the issue.

8.2 Internet Connection Sharing
Internet Connection Sharing (ICS) is useful if you wish to share a single Internet connection between several computers. To share such a connection, the host computer (the one connected directly to the Internet) must be configured to use ICS.

On the host computer, you need to share the internet connection by enabling ICS on it. Once you have enabled this sharing, other computers on your network can connect to the Internet using this shared internet connection.

**To enable ICS, follow these steps:**

1. Go to Start > Control Panel > Network and Internet > Network Sharing Center, then click on the “Manage network connections” text link on the right-hand Tasks pane (the fourth entry).
2. Right-click the connection that you want to share, and then click Properties. Note that you should share the one which connects you to the Internet.
3. Click the Sharing tab, and then select the “Allow other network users to connect through this computer’s Internet connection” checkbox.
4. You can also select the “Allow other network users to control or disable the shared Internet connection” checkbox. This option can be used to start an Internet connection if a user on your network...
demands it
5. You can also share services running on your system; click Settings and select the services you want to allow

When you enable ICS, your LAN connection gets a new static IP address and configuration. You also need to ensure that all computers on your network are configured to automatically get an IP address:
1. Go to Start > Control Panel > Network and Internet > Network Sharing Center, then click on the “Manage network connections” text link on the right-hand Tasks pane (the fourth entry)
2. Right-click a LAN connection and then click Properties
3. Click Internet Protocol Version 4 (TCP/IPv4) or Internet Protocol Version 6 (TCP/IPv6), and then click Properties
4. Click “Obtain an IP address automatically” or “Obtain an IPv6 address automatically”

You also need to change the settings of Internet Explorer to use ICS:
1. Start Internet Explorer
2. Click on the Tools button and then on Internet Options
3. Click on the Connections tab and here, click “Never dial a connection”
4. Click LAN Settings
5. Under Automatic configuration, clear the “Automatically detect
settings” and “Use automatic configuration script” checkboxes.
6. Under Proxy Server, clear the “Use a proxy server for your LAN” checkbox.

8.3 File sharing

Vista allows you to share your data in two broad ways. You can set up a folder, a driver, or a partition to share with others on your computer, or you can enable Public folders. Let’s take up each of these methods in detail.

8.3.1 Share any file or folder on your computer
This is the traditional means of sharing content. You generally enable a file, folder, or a disk for
sharing. This method gives you control over exactly what can be shared, with whom, and also the level of permissions that will be granted to any who are sharing the particular resource. To set up what kind of changes (if any) others can make to a file or folder, you need to set up sharing permissions. Such permissions can be granted to an individual or to a group of users on the same network. For example, you might allow some people to only view your shared files, while allowing others to both view and edit them.

If “Password protected sharing” is turned on for your computer, the person you are sharing with must have a user account and password on your computer in order to access your shares. You can turn password protection on or off in the Network and Sharing Center.

8.3.2 Use The Public Folders To Share Data
As mentioned earlier, each user account is granted some public folders that can be used to share content. With this method, you copy or move files to your Public folder and share them from that location. If you turn on file sharing for the Public folder, anyone with a user account and password on your computer, as well as everyone on your network, will be able to see all the files in your Public folder and subfolders. You cannot restrict people to just seeing some files in the Public folder. However, you can set permissions that either restrict people from accessing the Public folder altogether, or that restrict them from changing files or creating new ones. By default, network access to the Public folder is turned off unless you enable it.

To access your Public folder: open Windows Explorer by selecting Start > Documents, or by typing out “wi ex” in the search panel on the Start menu and pressing [Enter]. Inside Explorer, look to the left to find the Navigation pane. Here, under the “Favorite Links” heading, click on Public. If you have configured the Navigation pane so that the Public folder is not visible under “Favorite Links”, click “More”, and then click on Public.
8.3.3 Which Sharing Method Is Right For You?
Depending upon the way you work, you can choose either of these two methods, or, indeed, both.

**Share Any Folder If:**
1. You prefer to share folders directly from the location where they are stored. This can typically be used if you wish to share all your music files, or all your movies, and do not wish to waste additional space by copying them to the Public folders
2. You wish to set up different levels of sharing, with the help of permissions. This is especially useful if the data you wish to share is editable—you might want to share it with one group that can edit it, and another group that can only view / read it. This method also allows you to completely deny access to a group of people as well
3. You frequently create new files or update files that you want to share and don’t want to bother copying them to your Public folder

**Use the Public folder for sharing if:**
1. You prefer to share all your data from a single point on your computer
2. You want to be able to quickly see everything you have shared with others, just by looking in your Public folder
3. You want to segregate data that you are sharing from your own personal data. For example, you might want to share some documents or photos, without having to share your entire Documents of Pictures folders
4. You want to set sharing permissions for everyone on your network and don’t need to set sharing permissions for individuals
Windows Vista does a good job of balancing the old with the new, especially when it comes to managing data and user content. WinFS would have changed a lot, but for whatever reason, it is not a feature of Vista. Here, we take a look at what’s changed, and what’s the same.
When Vista was codenamed Longhorn, one of the features that were touted for it was a complete overhaul of the underlying file system. So much so that it would make a complete break with the way data was managed—WinFS, as the new file system was then named, aimed to take data out of the dark ages of a tree and folder structure into a new dawn that was a system built around a relational database. Such a system would therefore relate multiple points of data and metadata with each file and the data would essentially be fetched through a query, much like content is accessed in databases. WinFS was perhaps too drastic a departure from the norm, or perhaps Microsoft simply decided to drop the feature to rein in the slipping release date of Windows Longhorn.

Vista, however, manages to juggle the old with the new. While it still ships with the NTFS file system, it makes a break from the FAT and FAT32 files of Windows XP days—now Vista requires an NTFS partition to install itself. It also introduces the concept of tagging and metadata to sort and file your personal data. Finally, it ties these pieces together with a pervasive indexing service and a search feature that leverages the index in multiple places and in interesting ways. Let’s take a look at how data is managed under Windows Vista, starting with folder and file management and then on to program and service management.

9.1 Folder Management

Not much has changed with Vista and folders. The biggest addition is that Vista now allows symbolic links to both directories and files—these links are represented with the same arrow used to denote a shortcut. A symbolic link to a resource merely points to the destination and can therefore be removed without deleting the destination folder or file.

A symbolic link is thus merely a pointer to the actual location of a data. Under Windows 2000, directories had symbolic links and were called directory junctions, but it is with the advent of Vista
that this concept has been extended to the files themselves. When a user removes the symbolic link, the file or directory to which the link points remains unchanged.

### 9.1.1 Sharing Folders
Vista allows you to share your data in two broad ways. You can set up a folder, a driver, or a partition to share with others on your computer or you can enable Public folders. Let’s take up each of these methods in detail:

**Share any file or folder on your computer**
This is the traditional means of sharing content. You generally enable a file, folder, or a disk for sharing. This method gives you control over exactly what can be shared, with whom, and also the level of permissions that will be granted to any who are sharing the particular resource. To set up what kind of changes (if any) others can make to a file or folder, you...
need to set up sharing permissions. Such permissions can be granted to an individual or to a group of users on the same network. For example, you might allow some people to only view your shared files, while allowing others to both view and edit them.

**Use Public Folders to share content**

Vista also offers Public folders to each user account. Data stored in these public folders are accessible to all network users. With this method, you copy or move files to your Public folder and share them from that location.

Depending upon the version of Vista you have, the Public folders can be: Recorded TV, Public Documents, Public Videos, Public Music, Public Downloads, and Public Pictures.

If you turn on file sharing for the Public folder, anyone with a user account and password on your computer, as well as everyone on your network, will be able to see all the files in your Public folder and subfolders. You cannot restrict people to just seeing some files in the Public folder. However, you can set permissions that either restrict people from accessing the Public folder altogether, or that restrict them from changing files or creating new ones. By default, network access to the Public folder is turned off unless you enable it.

To access your Public folder: open Windows Explorer by selecting **Start > Documents**, or by typing out “**wi ex**” in the search panel on the Start menu and pressing [Enter]. Inside Explorer, look to the left to find the Navigation pane. Here, under the “Favorite Links” heading, click on Public. If you have configured the
Navigation pane so that the Public folder is not visible under “Favorite Links”, click “More”, and then click on Public. These locales can also be accessed by typing “Public” into the search field in the Start menu.

9.1.2 Virtual Folders To Manage Content
You can also create virtual folders to manage your content. A virtual folder is essentially a saved search and acts a gatherer and a pointer to data. Virtual folders have been discussed in detail in Chapter 5.

9.1.3 Setting Permissions For Folders
Sometimes you might be required to change the permission of a folder. Each folder can be given different levels of permissions depending upon what you want to do with that folder and whom you wish to share it with. With the use of user groups, you can also grant a particular group read and write access to a folder, while another group only gets to read from the folder; a third group might not be even able to list the content of the folder! You can set several permissions for each folder:

- Full Control—the group or user can do anything to this folder
- Modify—the group or user can modify the contents of this folder
- Read & execute—the folder can be read from, and programs within executed
- List folder contents—the folder’s contents can only be listed
- Read—read from the folder
- Write—write to the folder

Note that each of these permission settings also extend to a file—you can thus lock up a file, or set it free, just as you can a folder. These permissions can either be set at a user level or at a
group level. When you set permission for a group, all members of that group will inherit the permissions set; whereas only the individual user will be allowed if you set them for a single user.

To set permission to a folder or a file, right-click the folder and then click on Properties. Click on the third tab, Security, and then click on the Edit button. Pick your user account or the appropriate user group and then click the “Full control” checkbox just below (under the Permission for Users heading). Click OK and you’re done!

9.1.4 Changing Icons, Folder Type, Sizes Of Thumbnails
You can make visual changes to the way in which a folder is displayed inside Windows Explorer and even in the manner in which a folder displays its contents. When you open a folder, it uses one of several pre-built templates to display the contents within. A folder can be associated with one of these: All Items, Documents, Pictures and Videos, Music Details, and Music Icons template. The type of template that you choose will determine the manner in which the folder shows its content. You can thus change the template for a folder depending upon the majority content-type it stores.

You can also choose to change the icon of a particular folder. To make each of these changes:
1. Right-click on a folder and click Properties
2. Click on the last tab, “Customize”
3. Choose a template from the drop-down list “Use this folder type as a template”. Note that you can also associate the template above to sub-folders
4. Under the “Folder icons” category, click on the Change Icon but-
ton to associate the folder with an icon file of your choice

Under Explorer, you can also quickly toggle through the views available. To do this, click on the View button on the taskbar. Clicking on the arrow next to this button will open up a slider which you can use for a more granular approach.

9.2 The Task Manager

The task manager under Vista has seen some good improvements, mainly in the nature of the data it exposes to the user. For example, apart from the usual processes, the task manager now also displays the list of services running on the system. Another great addition to the Task Manager can be found under the Performance tab—the Resource Monitor. The Resource Monitor is an invaluable tool to keep a tab on the health and status of the system. It displays historical data and ongoing data of the system based on several sub-systems: the CPU, the disk, the network, and the memory. For each of these sub-systems, the Resource Monitor displays which system files or processes are chewing through the same. Thus, if you were to click on the CPU section, it would list down all the processes that are currently using the processor along with data on which process or file is using the most processor time. Similarly it shows information on RAM usage, disk usage, and network usage. To start the
Task Manager, press [Ctrl] + [Shift] + [Esc]. You can then move to the Performance tab and click on the Resource Monitor button to launch the Resource Monitor. To exit a program which is not responding, select it under the Applications tab and click on End task.

9.3 Startup Management

The faithful tool—msconfig—still serves us well under Vista. This system configuration tool can be used to change several aspects of Vista startup. To launch the tool, type “msconfig” in the search field on the Start menu. Let’s step through each of its tabs:

9.3.1 General
Lists choices for startup configuration modes:
- Normal startup. Starts Windows in the usual manner. Use this mode to start Windows after you are done using the other two modes to troubleshoot the problem
- Diagnostic startup. Starts Windows with basic services and drivers only. This mode can help rule out basic Windows files as the problem
- Selective startup. Starts Windows with basic services and drivers and the other services and startup programs that you select

9.3.2 Boot
Shows configuration options for the operating system and advanced debugging settings, including:
- **Safe boot:** Minimal. Boots to the Windows graphical user interface (Windows Explorer) in safe mode running only critical system services. Networking is disabled.
- **Safe boot:** Alternate shell. Boots to the Windows Command Prompt in safe mode running only critical system services. Networking and the graphical user interface are disabled.
- **Safe boot:** Active Directory repair. Boots to the Windows graphical user interface in safe mode running critical system services and Active Directory.
- **Safe boot:** Network. Boots to the Windows graphical user interface in safe mode running only critical system services. Networking is enabled.
- **No GUI boot.** Does not display the Windows splash screen when booting.
- **Boot log.** Stores all information from the boot process in the file %SystemRoot%\Ntbtlog.txt.
- **Base video.** Boots to the Windows graphical user interface in minimal VGA mode. This loads standard VGA drivers instead of display drivers specific to the video hardware on the computer.
- **OS boot information.** Shows driver names as drivers are being loaded during the boot process.
- **Make all settings permanent.** Does not track changes made in System Configuration. Options can be changed later using System Configuration, but must be changed manually. When this option is selected, you cannot roll back your changes by selecting Normal startup on the General tab.
9.3.3 Services
Lists all the services that start when the computer boots, along with their current status (Running or Stopped). If you suspect some services to be causing you boot problems, you can use the Services tab to enable or disable services at boot time: select “Hide all Microsoft services” to show only third-party applications in the services list. Clear the checkbox for a service to disable it upon your next boot. Note that disabling services that normally run at boot time might cause some programs to malfunction or result in system instability. Selecting “Disable all” will not disable some essential Microsoft services required for the operating system to start.

9.3.4 Startup
This tab lists all the applications that run when the computer boots. Note that this is different from system services. Alongside the application name, the tab also displays the name of their publisher, the path to the executable file, and the location of the Registry key or shortcut that causes the application to run.

To disable an application from running at startup, clear the checkbox next to it. Note that disabling applications that normally run at boot time might result in related applications starting more slowly, unexpectedly, or not running at all. If you suspect an application has been compromised, examine the Command column to review the path to the executable file.

9.3.5 Tools
Provides a convenient list of diagnostic tools and other advanced tools that you can run. To run a tool click on it and then on the Launch button in the lower right-hand corner of this window:
- About Windows—will display Windows version information
- System Information—
will display advanced information on your system
● **Remote Assistance**—you might sometimes require guidance on how to run a program or to troubleshoot an aspect of Vista. You can use this program to receive help from, or to offer help to, someone over the Internet
● **System Restore**—restores your computer to a prior state
● **Computer Management**—view and configure system settings and components
● **Event Viewer**—view monitoring and troubleshooting messages
● **Programs**—add or remove installed programs
● **Security Center**—opens the Security Center
● **System Properties**—offers an overview on your system
● **Internet Options**—view Internet Explorer settings
● **Internet Protocol Configuration**—view and configure network settings
● **Performance Monitor**—monitor the reliability and performance of the computer
● **Task Manager**—view details on programs and processes running on the computer
● **Disable UAC**—disable User Account Control (requires reboot)
● **Enable UAC**—enables User Account Control (requires reboot)
● **Command Prompt**—opens a command prompt
● **Registry Editor**—make changes to the Windows Registry
Windows Vista offers a variety of tools that perform maintenance and diagnostic tasks on your system. Most of the maintenance is done backstage and automatically. However, Vista also offers strong tools that allow you to peek inside the working of the operating system, automate tasks, and prepare thorough reports and logs for troubleshooting. Let’s take a look at some of these tools, starting with the most vital to our data—the backup feature.
10.1 The Backup And Restore Center

The basic file backup and restore features in Windows Vista make it easy for you to keep your data and your computer safe from user error, hardware failure, and other problems. In the Home Premium, Business, Ultimate, and Enterprise editions of Windows Vista, you can automate the entire backup process using a simple Wizard which will even schedule your future backups for you.

An important thing to consider here is that the Wizard does not allow you to back up specific folders and files, that is, you cannot select the data you want to back up. Rather, the backup program scans your hard drive for data that matches certain criteria, and backs it up. The criteria can be defined and modified through the Wizard, however. IT professionals might balk at this new system, now that they cannot determine precisely what needs to be backed up. For home users, it makes things easier—it is a very easy task to start backing up your data; there’s no need to worry about just what ought to be saved.

As to what gets backed up: all your personal files and folders—no system files are backed up by the program. Programs and system files are not included in the file backup, but they can be separately restored by reinstallation or by using either system restore points or Complete PC Backup and Restore—a feature available in the Business, Ultimate, and Enterprise editions of Vista.

The Backup and Restore Center also offers periodic backup for your data. Through a simple Wizard you can schedule your backups; note that future backups are incremental in nature. Which means that when the program is first run, it will back up all your personal files, but on future runs, it will only archive changes made to your files—thus if you added a slide to a presentation, after your first backup, the program will only add that particular slide to your original backup. Incremental backups thus make future backups much faster.
10.1.1 Setting Up A backup

Under the Start Menu, type “ba r” and you should see Backup and Restore appear under Programs. Click on the entry to launch the program. Inside the Backup and Restore Center, click on the ‘Back up files’ button. You will now be prompted to specify the location to which the backup will be stored. This can either be a blank CD/DVD media, a network drive, or a removable hard drive. Make your choice and click Next. You may not select which types of data you wish to back up. We recommend leaving everything at their default settings, then press Next to set up a daily schedule for backup. Finally, press “Save settings and start backup” to launch the first full backup.

Your scheduled jobs are run in the background by the back-up service. If you have set up automated backups to an optical
media, the service will prompt you to insert the media at the scheduled time.

**10.1.2 Recovering your data**

Of course, backup is only as useful as the process you use to recover your work. Under Vista, a recovery Wizard helps you select the files or folders to restore, and prompts you for the backup storage medium you used. It then restores your files. This feature can also help you migrate to a new PC—you can restore all your files right to your new computer. The restore feature can even create your user account on the new PC if it’s not already there.

Vista can restore your data in two ways: you can either run a complete restore from a backup, or you can restore a particular file to a “previous version” (see Chapter 4 for more on Previous
Versions). Restoring a previous version is especially useful if you wish to roll back changes that you made to a particular file. Previous versions of local files may be restored from shadow copies that are automatically created every day or from a backup. To use this facility, you can right-click on the file that you want to restore, and then select “Restore previous versions” from the menu. This will open up the Previous Versions tab, which will list the file’s available previous versions, if any, along with the date the previous version was created and its location. When selected, you can Open, Copy, or Restore a previous version of your file.

That apart, you can also restore all your data to a backup point, as is done traditionally. To recover a backup, launch the Backup and Restore Center (type “bar” in the search field under...
the Start menu) and click on the “Restore files” button under the “Restore files...” section. Click on “Files from the latest backup” and click Next. At this point, the Wizard will show you all the files and folders that have been backed up at the last run of the program. Here, you can either search for a specific folder or file, or ask the Wizard to “Select all”. Files or folders that you wish to restore need to be selected and added by pressing the “Add” button. Then click on Next, and you can choose to restore to the original location or to a new location. After you have made your choice, press “Restore” to start the process. If you have chosen to restore to the original location, where a copy of the data still resides, you will be prompted to either:

- Copy and Replace (Overwrites the existing file/folder)
- Don’t copy (Skips the restore of this file/folder)
- Copy, but keep both files (Restores the file with a different name)

10.1.3 Shadow Copy
As mentioned above, Vista also automatically creates copies of essential files. This feature is available in the Business, Ultimate, and Enterprise editions of Vista and is termed “Shadow Copy.” This feature automatically creates point-in-time copies of files as you work, so you can quickly and easily retrieve versions of a document you may have accidentally deleted. Shadow copy is automatically turned on in Vista, and creates copies—on a scheduled basis—of
files that have changed. Since only incremental changes are saved, minimal disk space is used for shadow copies. Note that shadow copies are deeply tied in with the System Restore feature of Vista. In order to save shadow copies of a file, you need to enable System Restore for the drive or partition that houses your files.

Shadow copies can be restored by right-clicking on a file/folder and choosing “Restore previous versions”.

### 10.2 System Restore

System Restore was introduced in Windows XP to enable people to restore their computers to an earlier state without losing personal data. System Restore is like an OS-level undo feature which allows you to roll back on system-wide changes—be it through software installs, driver updates or OS updates—without affecting your personal files, such as e-mails, documents, or photos. Restore points can be created across hard drives through the System Protection feature. You don’t have to worry about taking periodic system snapshots—System Restore automatically creates easily-identifiable restore points. You can also manually create restore points at any time.

To set up hard drives and partitions for System Restore, open the System window by typing in “Sys” in the Start Menu and clicking on “System”. Then click on the “System protection” option on the left pane of the System window. This will open up the “System Properties” window under the “System Protection” tab. You can enable disks and partitions to fall under the System Restore umbrella here—just select the checkboxes in front of the drives or partitions, and then click on “Create…”
10.3 Windows Complete PC Backup And Restore

The Ultimate, Business, and Enterprise versions of Vista also offer “Complete PC Backup and Restore,” which essentially creates a disk image of your entire computer that can then be saved on a hard drive, on network storage, or burnt to DVD. The Complete PC restore can also be initiated from the Windows Vista installation disc in the event of PC failure. While file restore is useful in cases of file loss and data corruption, this particular feature is most useful for disaster recovery when your PC malfunctions. Complete PC Backup and Restore is capable of restoring your entire PC environment, including the operating system, installed programs, user settings, and data files.

You should create an image of your hard drive through this program once you have completed the initial installation of the operating system and installed your favourite applications. Making an image such as this after every six months, or after you have made major changes to your system, is also good practice.

To start a Complete PC Backup, go to the Start Menu, type “bar” in the Search box and launch the Backup and Restore Center. Click on the “Back up computer” button here to start the process and trigger the Wizard. Start by choosing an appropriate backup medium—note that Vista will suggest a backup media based upon a scan of your system. If you are backing up to optical discs, keep a few in hand, or else you can choose to backup the image to a network or external drive. Once you have selected the medium to save your computer’s image to, press Next. If you have multiple disks or partitions on your system, you will be prompted to select the ones you wish to be backed up. You will then be taken to the confirmation screen which will summarise the process for you: the disks and partitions that will be backed up and how many DVDs will be required, for example. Press “Start backup” to start the process.

In the event that your system has been corrupted beyond
repair, or if you cannot boot to your computer, you can choose to restore your PC to a previously-saved image file. To start a complete PC restore, you must initialise it from system startup by booting the system through the Windows Vista DVD. Note here that restoring your computer to an image is a destructive process—all your data will be deleted, since partitions and drives that you wish to restore are formatted.

Insert the Windows Vista DVD disc and boot from it. Press Next and then select “Repair your computer”. Insert the media where you have backed up the image of your system, then click Next and select the “Windows Complete PC Restore” option from the “System Recovery Options” menu. Vista will let you choose the image file you wish to restore your computer to (if there are multiple images on your backup medium). By default, Vista will offer...
the most recent image, but you can select another version if you wish. Press Next to go to the confirmation screen, then press Finish. A dialog will ask for confirmation to erase the disk being restored—check the box and press OK to start the restore process.

10.4 The Control Panel

The Control Panel under Windows Vista has undergone a thorough overhaul. At first glance, the icons under the Vista Control Panel seem more than those present under XP. Thankfully, the ever-present Search box makes its presence felt in this window as well—in the upper-right hand corner, as usual. You can also search for any element of the Control Panel from the Search box in the Start Menu. This is a great feature: it means no longer having to dig through icons to find something you need to tweak or change.

When you open Control Panel, the keyboard focus is on the search box. Type “background”, or “mute” or “backup” or “resolution” or “defrag” and up come links to take you directly to the right UI to do that. You can search in your own words, without having to know the “official” name for anything. You don’t have to know what Control Panel icon to find, or what sub-page it’s on. The former is, of course, assuming you know what you’re looking for—to this end, Vista’s Control Panel offers categories and sections as tasks, rather than as tools. The interface also presents a better category view which shows links below categories—a set of options and tasks which the user has more likelihood of accessing. For example, the Windows Firewall category will show the sub-categories “Turn Firewall on or off” and “Allow a program through Windows Firewall”—both of which act as quick links to those specific tasks.

The new Control Panel also cross-references elements of Vista; for instance, Windows Firewall is under both Network and Internet, and under Security—so that you can find it no matter what you think of the Firewall as (a network or a security feature).
## Control Panel Components

<table>
<thead>
<tr>
<th>To launch this</th>
<th>Type this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Hardware</td>
<td>control hdwwiz.cpl</td>
</tr>
<tr>
<td>Add or Remove Programs</td>
<td>control appwiz.cpl</td>
</tr>
<tr>
<td>Administrative Tools</td>
<td>control admintools</td>
</tr>
<tr>
<td>Appearance Settings</td>
<td>control color</td>
</tr>
<tr>
<td>Audio Devices and Sound Themes</td>
<td>control mmsys.cpl</td>
</tr>
<tr>
<td>Date and Time</td>
<td>control timedate.cpl or control date/time</td>
</tr>
<tr>
<td>Display Settings</td>
<td>control desk.cpl or control desktop</td>
</tr>
<tr>
<td>Firewall</td>
<td>control firewall.cpl</td>
</tr>
<tr>
<td>Folder Options</td>
<td>control folders</td>
</tr>
<tr>
<td>Fonts</td>
<td>Explorer “\windows\fonts” or control fonts</td>
</tr>
<tr>
<td>Game Controllers</td>
<td>control joy.cpl</td>
</tr>
<tr>
<td>Infocard</td>
<td>control infocardcpl.cpl</td>
</tr>
<tr>
<td>iSCSI Initiator</td>
<td>control iscsicpl.cpl</td>
</tr>
<tr>
<td>Internet Options</td>
<td>control inetcpl.cpl</td>
</tr>
<tr>
<td>Keyboard</td>
<td>control main.cpl Keyboard or control keyboard</td>
</tr>
<tr>
<td>Mouse</td>
<td>control main.cpl or control mouse</td>
</tr>
<tr>
<td>Network Connections</td>
<td>control ncpa.cpl or control netconnections</td>
</tr>
<tr>
<td>Pen and Input Devices</td>
<td>control tabletpc.pcl</td>
</tr>
<tr>
<td>People Near Me</td>
<td>control collab.pcl</td>
</tr>
<tr>
<td>Phone and Modem Options</td>
<td>control telefon.cpl or control telephony</td>
</tr>
<tr>
<td>Power Options</td>
<td>control powercfg.cpl</td>
</tr>
<tr>
<td>Printers and Faxes</td>
<td>control printers</td>
</tr>
<tr>
<td>Regional and Language Options</td>
<td>control intl.cpl or control international</td>
</tr>
<tr>
<td>Scanners and Cameras</td>
<td>control sticpl.cpl</td>
</tr>
<tr>
<td>Windows Security Center</td>
<td>control wscui.cpl</td>
</tr>
<tr>
<td>Task Scheduler</td>
<td>control schedtasks</td>
</tr>
<tr>
<td>Text to Speech</td>
<td>control speech</td>
</tr>
<tr>
<td>System</td>
<td>control sysdm.cpl</td>
</tr>
<tr>
<td>User Accounts</td>
<td>control nusrmgr.cpl or control userpasswords or control userpasswords2</td>
</tr>
</tbody>
</table>
Vista’s Control Panel also tracks recent configuration tasks users have undertaken, keeping a list of the last three at the lower left corner of the Control Panel.

Like under XP, you can also launch specific elements of the Control Panel from a command line. The command line can either be a command window, or the Search box in the Start Menu. Refer to the table below to see a list of some of commands.

10.5 Windows Update

Back when Windows Update was introduced with Windows XP SP2, it was a Web service—you needed to start a Web browser in order to actually use the system update feature. With Vista, Update has transitioned to a system service, that is, it no longer runs on a Web page, but it part of the OS itself. This transition was largely done to address the concern that a Web service would not be secure enough to handle system updates. Under Vista, the Update feature provides updates for the operating system and related components, such as definition updates for Windows Defender, spam filter updates for Windows Mail, the usual system updates, and even updates to other Microsoft products such as the Office suite. The feature also allows third parties to register themselves under the service, such that updates to third-party software might also be pushed through the Windows Update feature.
Under Windows Vista Ultimate, the feature is also used to push through special software meant for the Vista Ultimate user, called Ultimate Extras; for example, DreamScene, the program that allows you to set a video file as your wallpaper, is downloadable through Windows Update.

By default, Windows Update is switched on during install, but can be turned off through the Control Panel. Vista also includes options which let you control how you are notified about the availability of updates, as well as the option to review and approve updates before they are downloaded or installed. You can also proactively check to see if any updates are available for your PC.

While you can deactivate Windows Updates, doing so is not recommended, since it is a vital component for ensuring that your system is plugged of newly-discovered holes, and that your virus definitions are up-to-date. An update is classified by Microsoft as Important, Recommended, and Optional. Under Vista, Windows Update can automatically download and install both Important and Recommended updates. Previously, only updates classified as High Priority could be installed automatically, and you had to manually select and download other available updates. You can also hide updates that are not relevant to your operating system (such as language packs). Details and notes around an update can be accessed by right-clicking on an update element and clicking on “View details”. Windows Update keeps a history of all the updates you have downloaded and installed on your operating system, which can be useful if your system gets unstable after an update and you need to track the guilty update.

Updating of the system and software occurs in the background, and flexible options are provided for completing the updating process. If an update requires a restart to complete installation, you can schedule the restart for a future time when it won’t disrupt your work. You can also postpone a previously-scheduled restart until your current work is complete. Finally, when a software update applies to a file in use, Windows Vista can save
the application’s data, close the application, update the file, and then restart the application.

10.6 Diagnostics

Anyone familiar with the diagnostic tools available under a Linux distribution will appreciate the fact that Windows XP obscured the inner workings of the operating system far too much for comfort. Windows Vista exposes several internal system logs and reports through a variety of tools and helps one better understand the working of the OS and thus, predict failures and identifies bottlenecks. Vista can also self-diagnose a number of common problems such as failing hard disks, memory problems, and networking issues. Disk Diagnostics, for example, can detect an impending hard drive failure and trigger data backup. It can also recommend disk replacement if necessary. Similarly, Vista can diagnose memory issues and networking issues: Windows Memory Diagnostics work with Microsoft Online Crash Analysis to detect crashes possibly caused by failing memory, prompting the user to schedule a memory test the next time the computer is started. Vista’s built-in diagnostics provides information needed to solve problems that can’t be automatically resolved. Whenever Windows Vista detects a potential problem, it raises an event. IT professionals can use these events to monitor, troubleshoot, and automatically set up the system to take corrective steps.
10.6.1 Memory Diagnostics
When Vista detects a memory problem such as a module, it will trigger this diagnostic program. This tool can also be run manually—it’s called MdSched.exe. If you do trigger it manually, the tool will ask to restart your system immediately, or will offer to run a memory test upon boot-up.

10.6.2 Network Diagnostics
The network diagnostic tool can be run from under the Network Center by clicking on the “Diagnose Internet Connection” link in the left-hand pane. If Vista is unable to connect to a network resource, it will prompt you to start this tool itself.

10.6.3 Resource Exhaustion
Out-of-memory messages, while not common, tend to hit you out of the blue. Vista offers a Resource Exhaustion Detection and Recovery feature that warns you when critical resources are low. The feature also identifies the processes consuming the largest amount of a given resource and helps you reclaim that resource. Resource Exhaustion Detection and Recovery constantly monitors your system automatically, so it requires no configuration. The feature also logs
such events along with data useful for subsequent analysis. These logs and events can be found in the System Log using Event Viewer.

10.6.4 Increasing Automation

Through the Task Scheduler, Windows Vista greatly increases the administrator’s ability to automate tasks. Task Scheduler is much more powerful in Windows Vista than in earlier versions of Windows. It can still be used to launch tasks at specific times or when the computer starts up. Under Vista though, the scheduler can be used to trigger tasks or programs when events occur. Thus if the Windows Diagnostics services detect that a drive has insufficient space, an admin can set up the system to track for the event and either send across a notification to the support desk, or to automatically resolve the issue.

Similarly, an admin can use the Task Scheduler to start disk defragmentation or perhaps a data backup when the computer is detected as idle. Programs can also be launched automatically upon locking or unlocking of a computer workstation. Tasks can also be queued under the Scheduler.

10.6.5 Automatic Recovery

Windows Vista automatically recovers from many types of failures, including failed services and corrupted system files. Every service has a recovery policy, so if it fails, Windows Vista may be able to restart it automatically. Windows Vista includes the Startup Repair Tool (SRT) to automatically fix common problems with startup. On boot failure, the system kicks into the SRT which automatically diagnoses the problem and tries to determine the cause of startup failure. If SRT is unable to resolve the issue, the system is rolled back to the last known working state.

The repair tool is also located in Vista’s install DVD. To start the tool from there, insert the DVD, restart your machine, and boot into the Vista DVD. You need to now choose View System Recovery Options (Advanced) from the menu and then select Startup Repair from the list of recovery tools.
10.6.6 Problem Reports And Solutions
When a program fails under Vista, a report is generated by the system’s tools. This particular report is usually sent to Microsoft for analysis and tracking—for example, if your video player crashes while playing a video file, the report and solutions tool will log all the details surrounding the crash. This report is then automatically sent to Microsoft and might come back with a solution such as “upgrade your software,” or “no solution currently available.” While most of this process is automated, you can see the details of these reports if you wish from the Control Panel: choose System and Maintenance, and click Problem Reports and Solutions. From the Tasks menu, you can view your history of problem diagnosis attempts, re-run a check for a problem, and even see the details of one of your problem reports.

If you don’t want Vista to automatically check for solutions, you can disable this functionality: click Change Settings under the Tasks menu to do so.

10.6.7 Reliability Monitor
The Reliability Monitor is an extremely useful and comprehensive diagnostic tool. It essentially tracks various subsystems of the operating system and keeps a log of all the failures and success—it is very useful for a variety of things: from diagnosing a particular subsystem, to keeping tab on the overall “reliability” of the system and rates the stability of the system using a reliability index. The tool tracks hardware failures, operating system failures, application failures, and other events that may indicate problems with the stability of your machine. You can filter the display to show all
events recorded on the computer or events for any one calendar day. Using the monitor you can track how stable your computer is, based on the number of crashes and get information on a large number of factors which affect system stability; the monitor for example also tracks the installs and uninstalls of software. The monitor can run from the Start menu by typing in “perfmon.msc” and pressing [Enter].

10.6.8 Disk Defragmenter
Vista includes a Disk Defragmenter which runs in the background as a low-priority task and defragments your system’s hard drive. The tool can also be scheduled to run automatically, and is set up by default to run every Sunday morning at 4 AM. This automated feature is the most important change made to the Defragmenter for Vista. Another

...and get detailed information about what went wrong.
Defrag carries over from XP, but better

small change made to the tool is that the disk layout view has been removed for a much cleaner look.
Games have consistently been the killer applications to move the hardcore audience from an older operating system to the newer variant. Inevitably, such moves are slow and painful no matter the transition: from DOS to Windows 3.x, from Windows 3.x to 98, from 98 to XP, and now from XP to Vista. Windows Vista presents perhaps the strongest reason for gamers to jump ship from XP since the DOS days—DirectX version 10 (DX10).
11.1 DirectX 10

DX10 is a set of APIs (an API is a layer of software that tells other software and hardware how to interact with it) that enables next-generation gaming; by “next-generation,” we mean beyond what consoles would be capable of in the years to come. DirectX 10 will offer a variety of new features and new tricks to old tasks which will take the visual fidelity and the performance of games built using the API to a new level. With DX10 in particular and Vista in general, Microsoft has shifted the onus of graphics rendering from the processor to the graphics card.

To achieve that end, DX10 has been built from the ground up to change the way 3D applications think about material management and load balance between the CPU and GPU. Direct3D 10, the component of DX10 that manages the 3D rendering tasks, takes advantage of the improved communication between the CPU and GPU and efficiently manages the data transfer between them. Through its advanced material management and load balancing tricks, DX10 games will bring in scenes with far greater complexity than currently possible, without ever increasing the CPU overhead. This frees up the processor to do other tasks such as AI and physics calculations, which further increases the immersion factor of these games.

As has been mentioned in Chapter 2, DX10 brings along a new driver model for the graphic cards. The new display driver model called WDDM is the main reason for DirectX10’s exclusivity to the operating system: Windows Vista will be the sole operating system (or at least the first) under which DirectX 10 and the games that support it will run. DirectX10 uses and leverages the virtualisation and architectural improvements of WDDM, in both the APIs as well as the underlying infrastructure.

11.1.1 In Greater Detail

DX10 allows programmers to create scenes with greater detail than before. For example, a technical demo of the Crysis game
showed character faces with pockmarks, handlebar moustaches, detailed lips and eyes, and realistic facial expressions. DX10 also offers better shadows. For DX9 games, you might have noticed that turning on shadows for every character on screen can quickly bring the frame rate to its knees. This is because shadow calculations were done using the CPU. Now this code path can be moved to the GPU and the result will be more detailed shadows and shadows that do not make the system crawl.
11.1.2 Richer scenes

DirectX10 allows for better volumetric effects. This feature was ably showcased by upcoming DX10 game *Alan Wake*, where one can see clouds and weather effects never seen before—including an extremely realistic thunderstorm and a tornado. DX10’s volumetric effects allow for thicker clouds and scattering of light. DirectX10 also offers more accurate reflections allowing modelling of choppy seas and water bodies.

Games like *Alan Wake* will bring surreal lighting to your desktop.

More art from *Alan Wake*
11.1.3 Procedural effects
One of the features of upcoming game engines is that of procedural generation of content. Entire forests filled with trees can thus be generated using hardware, which minimises the art requirement for a game, and also reduces the amount of textures the game needs to ship with (thus a game can pack in other goodies in the same DVD space). DX10 facilitates dynamic changes to a game, enabling game levels to evolve with the passing of time.

11.1.4 Motion blurring
In earlier versions of DirectX, game developers
were required to smudge the final image to achieve motion blur. In DirectX10, however, motion blur can be performed in object-space, simulating a camera exposure of an object across multiple sub-frames.

**11.1.5 Other benefits offered by DirectX 10 include:**

- A brand new Geometry Shader added between the vertex and pixel shaders
- Increased efficiency (Microsoft claims performance improvements up to six times that of DirectX 9 hardware running on Windows XP because of this)
- Less overhead on the processor will let a game put more objects on screen
- Virtualised memory for the GPU. The video card will be able to use space in system RAM to store information that does not fit on local video card memory
- Shader Model 4.0, which has a broader instruction set and offloads more work to the GPU
- Everything is now programmable and done with shaders
- Video cards will all have the same basic architecture; no more worrying about what one DX10 card offers vis-à-vis another
- Modelling fluid-like behaviour in for particle systems
Increase in memory texture. Textures were 2048 x 2048 or 4096 x 4096 in DirectX 9; in DX10 they’re 8192 x 8192

XInput. You can now use Xbox 360 peripherals with Windows Vista

More life-like materials and characters with:
- Animated fur & vegetation
- Softer / sharper shadows

Richer scenes; complex environments
- Thicker forests, larger armies!
- Dynamic and ever-changing in-game scenarios

Realistic motion blurring
- Volumetric effects
- Thicker, more realistic smoke/clouds

Other
- Realistic reflections/refractions on water/cars/glass

Reduced load on CPU
- Re-routes bulk of graphics processing to GPU
- Avoids glitching and system hangs during game play

11.2 The Games Explorer

One of the coolest features of Vista is the addition of the Games Explorer. This can be accessed from the Start menu directly by selecting Start > Games. You can also start it up by typing out “games” in the search panel in the Start Menu. The Games Explorer offers a one-stop launch-pad to showcase and play your games. Any game installed under Windows Vista will find a home here. Games can
be arranged by last played, developer, or by its ESRB rating. The best feature though is that the Games Explorer leverages the system’s rating to give you a quick view on whether or not the game will run on your system.

11.2.1 System Rating Or The Windows Experience Index

Based on the components of your system, Windows Vista assigns a numeric score to each of your core sub-systems. Thus your hardware is rated on the basis of: your system’s processor, the amount of RAM present in the system, the graphics capability of the system, the gaming graphics capability of the system, and the performance of the primary hard disk drive. Vista first assigns numeric ratings to each of these components; it then takes the lowest component score and rates the entire system by that score. This then becomes the system’s Windows Experience Index, or the system’s rating. This rating is then used to not only suggest software suitable to your system but also get a quick look at whether a game will run as intended by the developer on your system.

For example, let’s assume that your system rating is 4.2 and you have recently installed a game that requires a minimum of 3.0 and a recommended rating of 4.5 of your system. This game will run fine on your system but you might not be able to run it in full detail. Note that such information is only available from games that are Vista-aware and are labelled as “Games for Windows.”
11.2.2 ESRB rating
The Game Explorer also tries to download pertinent information on each game installed. For example the game’s official web site, its ESRB rating, developer and publisher information, genre and so on. The latter can be used with Parental Controls to control whether children ought to be allowed to play that particular game.

11.2.2 Playing Nice Under Vista
Windows Vista is a new operating system and as such it brings with it the usual incompatibilities and headaches. Some of these problems stem from poor driver support, some from the new manner in which Vista handles accounts and data. Let’s take a look at some such issues that a gamer is likely to face under Windows Vista:

1. Dude, where’s my driver? This problem is much less serious now than it was back when Vista launched. Display drivers especially were scarce and NVIDIA was a big defaulter here. So much so that some Vista gamers launched a class-action suit against NVIDIA for their alleged lax driver releases under Vista. All is well now; Vista drivers are coming fast from both the major graphic card vendors.

2. UAC. The admin account no longer has admin rights under Vista. Some older titles might have problems writing files to sys-
tem folders under this scenario (the Program Files folder is considered a system folder). The easiest solution to this problem is to install the game in the user’s personal folder, for which the user has all the required permissions. If you are still stuck with an errant game, consider changing the permission settings for that particular game’s folder (See box Granting Permissions).

3. Copy-protection issues. Some games use copy-protection techniques to prevent piracy. Some of these schemes might not work under UAC, since the schemes presume full admin-access at all times. For example, games using the StarForce copy-protection face problems under Vista. StarForce does not work properly in Vista environments. However, StarForce has recently released a new version of its software that is certified to be compatible with Vista.

4. Breaking one’s head against the firewall. Some games require access to the Internet to function properly (multiplayer titles, or MMORPG games, for example). However, Windows has relatively recently added a firewall feature (with Windows XP SP2) and some games are simply not aware of such a security checkpoint. These therefore fail to log themselves in as exceptions to the firewall and are promptly blocked by Windows (XP or Vista). The solution? Add the game to the exception list of the firewall yourself (See box Opening Firewalls)